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This guide describes how to install, configure, and use webMethods Oracle Applications Adapter.
It contains information for webMethods administrators and application developers who want to
exchange data with WmOAAdapter systems.
To use this guide effectively, you should:
Understand the Oracle Applications system and how your organization uses specific modules
and business transactions
Understand database concepts and SQL
Understand the terminology and basic operations of your operating system
Be familiar with the setup and operation of webMethods Integration Server
Have a general idea about how to perform basic tasks with Software AG Designer

Document Conventions
Convention

Description

Bold

Identifies elements on a screen.

Narrowfont

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Italic

Identifies:
Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Monospace font

Identifies:
Text you must type in.
Messages displayed by the system.
Program code.

{}

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

|

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).
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Online Information and Support
Software AG Documentation Website
You can find documentation on the Software AG Documentation website at http://
documentation.softwareag.com.

Software AG Empower Product Support Website
If you do not yet have an account for Empower, send an email to empower@softwareag.com with
your name, company, and company email address and request an account.
Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.
You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.
To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.
To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.
If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give us
a call.

Software AG TECHcommunity
You can find documentation and other technical information on the Software AG TECHcommunity
website at http://techcommunity.softwareag.com. You can:
Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.
Access articles, code samples, demos, and tutorials.
Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.
Link to external websites that discuss open standards and web technology.

Data Protection
Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

webMethods Oracle Applications Adapter Installation and User’s Guide 6.0

9

10

webMethods Oracle Applications Adapter Installation and User’s Guide 6.0

1 About Oracle Apps Adapter
■

Overview of the Adapter .................................................................................................

12

■

Architecture and Components ........................................................................................

12

■

Package Management ....................................................................................................

14

■

Adapter Connections ......................................................................................................

15

■

Transaction Definitions ...................................................................................................

18

■

Adapter Services ............................................................................................................

18

■

Adapter Notifications ......................................................................................................

20

■

Using Version Control Systems to Manage Adapter Elements ......................................

21

■

Optimize Infrastructure Data Collector Support for Oracle Applications Adapter ...........

21

■

Viewing the Adapter's Update Level ...............................................................................

22

■

Controlling Pagination ....................................................................................................

22

webMethods Oracle Applications Adapter Installation and User’s Guide 6.0

11

1 About Oracle Apps Adapter

Overview of the Adapter
webMethods Oracle Applications Adapter is an add-on to webMethods Integration Server that
allows you to exchange data with Oracle Applications systems. The adapter provides seamless
and real-time communications to and from the Oracle Applications system without requiring
changes to the existing security infrastructure.
Using Oracle Apps Adapter, Integration Server clients can run services that execute transactions
to retrieve data from, and insert and update data into, Oracle Applications systems. For example,
you can use Oracle Apps Adapter in a flow that receives an XML-based purchase order and then
inserts a sales order into an Oracle Applications system.
The adapter also provides user interfaces that enable you to configure and manage adapter
connections, adapter services, adapter notifications, and transaction definitions.
Sample transaction definitions are available that you can use when configuring your own adapter
services. You can use the samples as they are provided, or you can modify them or create new
transaction definitions customized for your needs. This flexibility facilitates integration with highly
customized Oracle Applications .
For Oracle Applications integrations that are not highly customized, there are sets of predefined
transaction services that are available as add-ons to Oracle Apps Adapter. Predefined transaction
services are complete, ready-to-use flow services that simplify the process of integrating with
Oracle Applications systems. In most cases, you can use these services as they are supplied. You
only need to modify a connection to specify your Oracle Applications system connection
information.

Architecture and Components
Oracle Apps Adapter provides a set of user interfaces, services, and templates that enable you to
create integrations with Oracle Applications systems. The adapter is provided as a single package
that must be installed on Integration Server. For detailed installation instructions, see “Installing
Oracle Apps Adapter ” on page 24. For a list of the operating systems, Oracle products, and
webMethods products supported by Oracle Apps Adapter , see webMethods Adapters System
Requirements .
Because Oracle Apps Adapter uses an Oracle Thin JDBC driver to access the data in an Oracle
Applications system, the adapter requires the driver to be installed and loaded in the packages
directory of Integration Server.
The following diagram shows at a high level how the adapter components connect to an Oracle
Applications system.

12
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webMethods Integration Server . Oracle Apps Adapter is installed and runs on Integration
Server.
WmART Package. The WmART package provides a common framework and later adapters
to use Integration Server functionality, making Integration Server the run-time environment
for Oracle Apps Adapter. The WmART package is installed with Integration Server.
Oracle Apps Adapter . Oracle Apps Adapter is delivered as a single package called
WmOAAdapter .
Oracle Apps Adapter provides Integration Server Administrator and Designer user interfaces
that enable you to configure and manage adapter connections, adapter services, adapter
notifications, and transaction definitions.
Adapter Connection Templates. Adapter connections enable Oracle Apps Adapter to connect
to Oracle Applications systems. You must configure an adapter connection before you can
configure adapter services or notifications.
The adapter provides a template for adapter connections in Integration Server Administrator.
For a detailed description of adapter connections, see “Adapter Connections” on page 15.
Adapter Service Templates. Adapter services enable Integration Server to initiate and perform
operati0ons on the Oracle Applications system.
The adapter provides templates for adapter services in Designer. For a detailed description of
adapter services, see “Adapter Services” on page 18.
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Adapter Notification Templates. Adapter notifications enable Oracle Apps Adapter to process
data from an event that has occurred on an Oracle Applications system. Oracle Apps Adapter
uses a polling mechanism that supports polling services to provide Oracle Applications
-to-Integration Server notification capabilities.
The adapter's polling notification template is available in Designer. For a detailed description
of polling notifications, see “Adapter Notifications” on page 20.
Oracle Thin JDBC Driver. Enables Oracle Apps Adapter to access the data in an Oracle
Applications system. For more information about the JDBC driver, see “Setting Up Your
Adapter's Environment” on page 40.
webMethods Repository or Shared Cache. The repository or shared cache contains the adapter's
transaction definition information. It also maintains the status of services running in the cluster.
The following diagram illustrates a typical business-process integration involving Oracle Apps
Adapter.

Package Management
Oracle Apps Adapter is provided as a package called WmOAAdapter . You manage the adapter
package the same way you manage any package on Integration Server. There are several
considerations regarding how you set up and manage your packages on Integration Server, such
as those described in the following list.
Create user-defined packages for your connections, adapter services, and adapter notifications.
See “ Oracle Apps Adapter Package Management” on page 28 for details.

14
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Understand how package dependencies work so you make the best decisions regarding how
you manage your connections, adapter services, and adapter notifications. See “Setting Package
Dependencies” on page 31 for details.
Control which development groups have access to which adapter services and adapter
notifications. See “Group Access Control” on page 31 for details.
Understand how clustering, an advanced feature of Integration Server, works to effectively
manage your adapter services and adapter notifications. See “ Oracle Apps Adapter in a
Clustered Environment” on page 32 for details.
Enable and disable packages. See “Enabling and Disabling Packages” on page 29 for details.
Load, reload, and unload packages. See “Loading, Reloading, and Unloading Packages” on
page 30 for details.

Adapter Connections
Oracle Apps Adapter connects to an Oracle Applications system using a JDBC driver and adapter
connections.
Adapter connections contain sets of connection parameters, including the logon parameters that
the adapter needs to connect to the Oracle Database Server supporting the release of the Oracle
Applications Server. Using Integration Server Administrator, you configure Oracle Apps Adapter
connections for use with adapter services and adapter notifications. You must configure an adapter
connection before you can configure an adapter service or adapter notification.
If you are configuring your own adapter services, you configure one or more adapter connections
at design time to use in integrations. To use Oracle Apps Adapter you must first configure one or
more adapter connections, depending on your environment. For example, if you have multiple
installations of Oracle Applications , you can access each installation using separate adapter
connections. In addition, if you have a test system and a production system, you can configure an
adapter connection for each system.
If you are using the predefined transaction services, you do not need to configure a connection
because one is included. The underlying transaction definitions used by the predefined transaction
services have all been preconfigured to use the same connection, allowing the services to connect
to only one Oracle Applications system at a time. You only need to edit the connection parameters
to specify your database connection information. For more information about how connections
are used with the predefined transaction services, see the webMethods Oracle Applications Predefined
Transaction Services Installation and User's Guide for the version of Oracle Applications with which
you are using the adapter.
For instructions for configuring, viewing, editing, enabling, and disabling Oracle Apps Adapter
connections, see “Adapter Connections” on page 39. For information about setting user privileges,
see webMethods Integration Server Administrator’s Guide for your release.

Using the JDBC Driver to Connect to Oracle Applications
Oracle Apps Adapter connections access databases using the Oracle Thin JDBC driver.
webMethods Oracle Applications Adapter Installation and User’s Guide 6.0
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The JDBC driver must be installed on the Integration Server machine and loaded when the adapter
starts. See “Installing Oracle Apps Adapter ” on page 24 for instructions.

Transaction Management of Oracle Apps Adapter Connections
Oracle Apps Adapter connections support the LOCAL_TRANSACTION transaction type. With
this transaction type, all of the operations on the same connection in one transaction boundary
will be committed or rolled back together. A transaction boundary means the scope of the
transaction, from the beginning to the end of a transaction. It can be in one adapter service, one
flow service, one Java service, or several steps in a flow service. This transaction type maintains
the integrity of your business documents.
Note:
The adapter also provides a NO_TRANSACTION type; however, we strongly suggest that you
do not use it. Using this type of configuration the connection automatically commits (Auto
Commit) all database operations.
When you configure a connection, the transaction type that you choose determines the type of
transaction management that the connection's operations use implicitly. Implicit transactions are
managed by the Integration Server transaction manager.
You can also explicitly manage transactions using built-in services. See “Built-In Transaction
Management Services” on page 99 for information about, and examples of, explicitly managing
transactions.

Connection Pools
Integration Server includes a connection management service that dynamically manages connections
and connection pools based on configuration settings that you specify for the connection. All
adapter services use connection pooling.
A connection pool is a collection of connections with the same set of attributes. Integration Server
maintains connection pools in memory. Connection pools improve performance by enabling
adapter services to reuse open connections instead of opening new connections.

Run-Time Behavior of Connection Pools
When you enable a connection, Integration Server initializes the connection pool, creating the
number of connection instances you specified in the connection's Minimum Pool Size field when
you configured the connection. Whenever an adapter service needs a connection, Integration
Server provides a connection from the pool. If no connections are available in the pool, and the
maximum pool size has not been reached, the server creates one or more new connections (according
to the number specified in the Pool Increment Size field) and adds them to the connection pool.
If the pool is full (as specified in Maximum Pool Size field), the requesting service will wait for
Integration Server to obtain a connection, up to the length of time specified in the Block Timeout
field, until a connection becomes available. Periodically, Integration Server inspects the pool and
removes inactive connections that have exceeded the expiration period that you specified in the
Expire Timeout field.
16
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You can enable the system to retry the initialization any number of times, at specified intervals.
For information about configuring connections, see “Adapter Connections” on page 39.

Built-In Services For Connections
Integration Server provides built-in services that enable you to programmatically control
connections. You can use them to enable and disable a connection, and to return usage statistics
and the current state (Enabled or Disabled) and error status for a connection. These services are
located in the WmART package, in the pub.art.connection folder.
There are also two built-in services, pub.art.service:setAdapterServiceNodeConnection and
pub.art.notification:setPollingNotificationNodeConnection, that enable you to change the connection associated
with an adapter service or notification respectively. Read more about these services in the section
“Changing the Connection Associated with an Adapter Service or Polling Notification at Design
Time” on page 17.

Changing the Connection Associated with an Adapter Service
or Polling Notification at Design Time
Integration Server provides built-in services that you can use at design time to change the connection
associated with an adapter service or polling notification. These built-in services are named
pub.art.service:setAdapterServiceNodeConnection and pub.art.notification:setPollingNotificationNodeConnection.
Using these services, you can change the specific connection associated with an adapter service
or polling notification at design time so that you do not need to recreate adapter services or polling
notifications.
Note:
These built-in services can be run at design time only; do not use them within an Integration
Server flow or Java service. You must run this service directly from Designer by selecting the
service and running it.
For details, see the webMethods Integration Server Built-In Services Reference for your release.
Other built-in services enable you to control connections; for more information, see “Built-In
Services For Connections” on page 17.

Changing the Connection Associated with an Adapter Service
at Run Time
Integration Server enables you to dynamically select the connection a service uses to interact with
the adapter's resource. This feature enables one service to interact with multiple, similar backend
resources.
For example, a service can be defined to use a default connection that interacts with your company's
North American Oracle Applications database. However, at run time you can override the default
connection and instead use another connection to interact with the company's European Oracle
Applications database.
webMethods Oracle Applications Adapter Installation and User’s Guide 6.0
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For more information about overriding a service's default connection at run time, see “Dynamically
Changing a Service's Connection at Run Time” on page 44.

Transaction Definitions
Transaction definitions define the processing that the adapter services perform in Oracle
Applications systems. Transaction definitions can map to open interface tables, stored procedures,
views, and raw SQL statements.
Sample transaction definitions are available that you can use to configure your own adapter
services. You can modify the sample transaction definitions or create new transaction definitions
customized for your needs. For more information about the sample transaction definitions, see
the webMethods Oracle Applications Adapter Sample Transaction Definitions User’s Guide .
If you are using the predefined transaction services, you do not need to do anything with the
transaction definitions. However, if you want to customize any of the transaction definitions from
which the services were partially created, or if you want to configure new transaction definitions,
you can do so using the adapter's page in Integration Server Administrator. For example, you
might want to customize a transaction definition for a send service if the service delivers more
business document fields than you need. For more information about the transaction definitions
used with the predefined transaction services, see the webMethods Oracle Applications Predefined
Transaction Services Installation and User's Guide for the version of Oracle Applications with which
you are using the adapter.
For information about importing, exporting, configuring, and managing transaction definitions,
see “Transaction Definitions” on page 49.

Adapter Services
Adapter services enable an Integration Server to initiate operations on Oracle Applications systems.
Adapter services use transaction definitions to determine the processing to perform on an Oracle
Applications system.
Oracle Apps Adapter enables you to configure customized adapter services that you can use to
integrate with Oracle Applications systems. You configure adapter services using adapter service
templates, which are provided with Oracle Apps Adapter. For more information about the
templates, see “Adapter Service Templates” on page 19.
You will need to configure your own adapter services if:
You are using the predefined transaction services but you have a highly customized Oracle
Applications system and some of the predefined transaction services do not meet your needs,
or
You want to continue to use the adapter services that were created and generated with versions
of Oracle Apps Adapter earlier than 6.0.
You can create a webMethods client that invokes the adapter service, or you can integrate the
adapter service into an existing flow service. For example, if you want to code a webMethods
client that creates a customer order from a purchase order, code the webMethods client to invoke
the service that executes the OEOrderImport transaction of Oracle Order Management.
18
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Adapter Service Templates
You use adapter service templates to configure adapter services. Each adapter service template
represents a specific Oracle Applications operation. For example, the Insert SQL template enables
you to insert business documents into the Oracle Applications open interface tables in one operation.
Adapter service templates contain all of the code that is necessary to perform an operation on an
Oracle Applications system, but without the Oracle Applications data specifications. You provide
these specifications through transaction definitions when you configure an adapter service.
Configuring a new adapter service from an adapter service template is straightforward. Using
Designer, you assign the service a default adapter connection, select the adapter service template,
and supply your transaction definition.
After you configure an adapter service, you can incorporate it into a flow service or Java service
to interact with an Oracle Applications system. For example, you can create a flow service that
collects customer order information from another one of your backend systems and then within
that service you can call an Insert SQL service to insert the customer order information into your
Oracle Applications system.
Oracle Apps Adapter provides the following adapter service templates for adapter services:
Adapter Service Template Description
Insert SQL

This type of service is used to insert business documents into Oracle
Applications using the open interface tables names specified in the
IS-to- Oracle Applications transaction definitions.
You can execute this service with an Error service (using the Simple
SQL service template) to verify the status of the import performed
by the concurrent process.
See “Configuring Insert SQL Services” on page 65 for instructions.

Compound Select SQL

This type of service is used to query an Oracle Applications system
and retrieve data based on the query conditions (specified in either
a SQL tree or stored procedure).
You can execute this service with an Acknowledge service (using
the Simple SQL service template) to notify Oracle Applications that
the document has been processed. This prevents the document from
being retrieved multiple times.
See “Configuring Compound Select SQL Services” on page 66 for
instructions.

Simple SQL

Use this template to create Acknowledge services or Error services:
When used with a Compound Select SQL service, Acknowledge
services maintain an accurate status of the transactions within
the Oracle system. You create an Acknowledge service from an

webMethods Oracle Applications Adapter Installation and User’s Guide 6.0
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Adapter Service Template Description
Oracle Applications -to-IS transaction definition that either calls
a stored procedure or executes a SQL UPDATE statement to tell
the Oracle Applications instance that the transaction has been
processed.
When used with an Insert SQL service, Error services query
Oracle Applications for errors that might have occurred during
the import process. You create an Error service from an IS-toOracle Applications transaction definition that is based on a
stored procedure, view, or SQL SELECT statement. The service
receives the query parameters for the SQL statement via the
service specification.
See “Configuring Simple SQL Services” on page 68 for instructions.

Predefined Transaction Services
Predefined transaction services are complete, ready-to-use flow services that simplify the process
of integrating with Oracle Applications systems. Available as an add-on to Oracle Apps Adapter,
predefined transaction services are available for different versions of Oracle Applications .
In most cases, you can use these services as they are supplied. To use predefined transaction
services you must reconfigure the associated connection to match your Oracle Applications system
connection information. However, if necessary, you can use the adapter to modify the services or
their underlying transaction definitions.
See the webMethods Oracle Applications Predefined Transaction Services Installation and User's Guide
for the version of Oracle Applications with which you are using the adapter for a detailed
description of the components involved in the predefined transaction services. The guides also
include information about the transaction definitions used by the predefined transaction services,
including where to locate them and how to import them into your webMethods system.

Adapter Notifications
An adapter notification enables Oracle Apps Adapter to retrieve data from an Oracle Applications
system at regular intervals and publish a document. The notification retrieves the data based on
query conditions specified in either an SQL Tree or a stored procedure.
You must create a trigger on the Integration Server for the publishable document associated with
the notification. This trigger identifies the receiver of the published document. For more information
about creating triggers and working with publishable documents, see the Publish-Subscribe
Developer’s Guide for your release.
Note:
Adapter notifications do not use Acknowledge services. Without an Acknowledge service you
may not be able to guarantee that the Oracle Applications event is only retrieved once. If you
need to guarantee that the Oracle Applications event is retrieved only once, you should create
20
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the notification using a stored procedure, and that stored procedure should update the record
in Oracle Applications to indicate that it is being processed.
Any exception produced by the notification is logged in the Integration Server Error Audit Log.
Use Designer to configure, edit, and delete polling notifications. All notifications are configured
from a notification template and require a configured connection.
Beginning with Integration Server 8.0, you can choose whether the asynchronous notification
templates use JMS APIs to publish messages to Integration Server or webMethods Broker APIs to
publish notification messages to webMethods Broker. For more information, see “Adapter
Notifications” on page 75.
Note:
To use the JMS protocol with both polling and listener asynchronous notifications, you must
first configure a JMS connection alias on Integration Server. For more information about
configuring Integration Server for JMS messaging, see the webMethods Integration Server
Administrator’s Guide for your release.
Using Integration Server Administrator you can display all polling notifications that have been
configured for Oracle Apps Adapter. You can also enable notifications and schedule them for
execution. A notification can also be disabled; however, this is separate from the containing
Integration Server package being disabled. If the Integration Server package is disabled, the
notification is suspended, but the notification is not disabled. When the package containing the
notification is enabled, the scheduled execution resumes. If the notification is disabled it will not
be executed until it is enabled.
For instructions about how to configure and manage notifications, see “Adapter Notifications” on
page 75.

Using Version Control Systems to Manage Adapter Elements
The adapter supports the Version Control System (VCS) Integration feature provided by Designer.
When you enable the feature in Integration Server, you can check adapter packages or elements
into and out of your version control system from Designer. For more information about the VCS
Integration feature, see the Configuring the VCS Integration Feature.
Beginning with Integration Server 8.2 SP3, the adapter supports the local service development
feature in Designer. This feature extends the functionality of the VCS Integration feature to check
package elements and their supporting files into and out of a VCS directly from Designer. For
more information about local service development and how it compares to the VCS Integration
feature, see the webMethods Service Development Help.

Optimize Infrastructure Data Collector Support for Oracle
Applications Adapter
Optimize Infrastructure Data Collector monitors the system and operational data associated with
webMethods run-time components such as Integration Servers, Broker Servers, Brokers, and
adapters, and reports the status of these components on Optimize for Infrastructure or other
webMethods Oracle Applications Adapter Installation and User’s Guide 6.0
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external tools. When you start monitoring an Integration Server, Infrastructure Data Collector
automatically starts monitoring all ART-based adapters that are installed on the Integration Server.
For information about monitored key performance indicators (KPIs) collected for the monitored
adapter components, see the Administering webMethods Optimize and webMethods Optimize User’s
Guide for your release.

Viewing the Adapter's Update Level
You can view the list of updates that have been applied to the adapter. The list of updates appears
in the Updates field on the adapter's About page in Integration Server Administrator.

Controlling Pagination
When using the adapter on Integration Server, you can control the number of items that are
displayed on the adapter Connections screen and Notifications screen. By default, 10 items are
displayed per page. Click Next and Previous to move through the pages, or click a page number
to go directly to a page.
To change the number of items displayed per page, set the watt.art.page.size configuration
parameter and specify a different number of items.
To set the number of items per page
1. From Integration Server Administrator, click Settings > Extended.
2. Click Edit Extended Settings. In the Extended Settings editor, add or update the
watt.art.page.size configuration parameter to specify the preferred number of items to display
per page. For example, to display 50 items per page, specify:
watt.art.page.size=50

3. Click Save Changes. The configuration parameter appears in the Extended Settings list.
For more information about working with extended configuration settings, see the webMethods
Integration Server Administrator’s Guide for your release.
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Overview
This chapter explains how to install, upgrade, and uninstall webMethods Oracle Applications
Adapter. The instructions use the Software AG Installer and the Software AG Uninstaller wizards.
For complete information about the wizards or other installation methods, or to install other
webMethods products, see the Installing webMethods Products On Premises for your release.

Requirements
For a list of the operating systems, Oracle products, and webMethods products supported by
Oracle Apps Adapter, see the webMethods Adapters System Requirements .
Oracle Apps Adapter has no hardware requirements beyond those of its host Integration Server.

Installing Oracle Apps Adapter
To install the adapter on AS/400, you must use the Installer's console mode, described in the
Installing webMethods Products On Premises for your release.
Note:
If you are installing the adapter in a clustered environment, you must install it on each Integration
Server in the cluster, and each installation must be identical. For more information about working
with the adapter in a clustered environment, see “ Oracle Apps Adapter in a Clustered
Environment” on page 32.
To install Oracle Apps Adapter
1. Download Software AG Installer from the Empower Product Support Web site.
2. If you are installing the adapter on an existing Integration Server, shut down the Integration
Server.
3. Start the Installer wizard.
4. Choose the webMethods release that includes the Integration Server on which to install the
adapter. For example, if you want to install the adapter on Integration Server 9.12, choose the
9.12 release.
5. Specify the installation directory as follows:
If you are installing on an existing Integration Server, specify the webMethods installation
directory that contains the host Integration Server.
If you are installing both the host Integration Server and the adapter, specify the installation
directory to use.
The Installer will install the adapter in the Integration Server_directory \packages directory.
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6. In the Product Selection list, select Adapters >webMethods Oracle Applications Adapter.
You can also choose to install documentation.
Important:
Depending on your license, you might see options for predefined transaction services.
7. After the installation is finished, go to the host Integration Server_directory directory and open
the OracleAppsInstall.log file. Read the file to ensure that the installation process completed
successfully.
8. Start the host Integration Server.
9. When Installer installed the adapter, it also installed a set of sample transaction definitions
you can use in your adapter services. If you want to use these sample transaction definitions,
you must import them into the repository server that Integration Server is using. For information
about which sample transaction definitions are available for import, see webMethods Oracle
Applications Adapter Sample Transaction Definitions User’s Guide . For instructions on importing
the sample transaction definitions into the repository server, see “Importing Transaction
Definitions” on page 50.
Note:
For Integration Server version 6.5x, transaction definitions used by adapter services you
have created must reside in the repository. In earlier versions of the adapter, once you
generated an adapter service, you could remove its underlying transaction definition from
the repository. However, if you are upgrading to Oracle Apps Adapter version 6.0 you must
reestablish the contents of the repository by importing the transaction definitions for your
adapter services. This is necessary for your adapter services and adapter notifications to
function properly.
Note:
If you are using Integration Server version 7.1 or later, the repository is not maintained with
Integration Server. Instead, the adapter stores the transaction definitions an external database
that serves as a shared cache.
10. Install a JDBC driver that complies with the software requirements in the webMethods Adapters
System Requirements in the Integration Server_directory \packages\WmOAAdapter\code\jars
directory.
Note:
If the host Integration Server has already been configured to use a JDBC driver that is
compatible with the adapter, you do not need to install a separate JDBC driver.
If the adapter does not have access to the Java classes for the JDBC driver, you will receive the
following error when the adapter attempts to connect to the database:
Could not connect: No suitable driver

If the JDBC driver loads successfully but cannot connect to the database for some reason, the
resulting error message usually includes some driver-specific codes or messages. The most
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common source of such errors is an invalid user name or password for the database. Consult
your driver documentation for details.
Note:
Software AG recommends that you install the latest fix to include updates from previous
fixes to this adapter.

Uninstalling Oracle Apps Adapter
To uninstall Oracle Apps Adapter
1. Shut down the host Integration Server. You do not need to shut down any other webMethods
products or applications that are running on your machine.
2. Start Software AG Uninstaller, selecting the webMethods installation directory that contains
the host Integration Server. In the product selection list, select Adapters > webMethods Oracle
Applications Adapter. You can also choose to uninstall documentation.
3. Restart the host Integration Server.
4. After uninstallation is complete, go to the Integration Server_directory directory and open the
OracleAppsInstall.log file. Read the file to ensure that the uninstallation process completed
successfully.
5. Uninstaller removes all Oracle Apps Adapter related files that were installed. However,
Uninstaller does not delete files created after you installed the adapter (for example, user-created
or configuration files), nor does it delete the adapter directory structure. You can go to the
Integration Server_directory \packages directory and delete the WmOAAdapter directory.
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Overview
The following sections describe how to set up and manage your Oracle Apps Adapter packages,
set up Access Control Lists (ACL), and use the adapter in a clustered environment.

Oracle Apps Adapter Package Management
Oracle Apps Adapter is provided as a package called WmOAAdapter . You manage the
WmOAAdapter package as you would manage any package on Integration Server.
When you configure connections, adapter services, and adapter notification, define them in
user-defined packages rather than in the WmOAAdapter package. Doing so will allow you to
manage the package more easily.
As you create user-defined packages in which to store connections, adapter services, and adapter
notifications, use the package management functionality provided in Designer and set the
user-defined packages to have a dependency on the WmOAAdapter package. That way, when
the WmOAAdapter package loads or reloads, the user-defined packages load automatically. See
the following diagram:

Package management tasks include:
Setting package dependencies (see “Package Dependency Requirements and Guidelines” on
page 29).
“Enabling and Disabling Packages” on page 29.
“Loading, Reloading, and Unloading Packages” on page 30.
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Package Dependency Requirements and Guidelines
The following are dependency requirements and guidelines for user-defined packages. For
instructions for setting package dependencies, see the webMethods Service Development Help for
your release.
A user-defined package must have a dependency on its associated adapter package,
WmOAAdapter . The WmOAAdapter package has a dependency on the WmART package.
These dependencies ensure that Integration Server automatically loads or reloads all packages
in the following order at startup:
1. WmART package.
2. Adapter package.
3. User-defined packages.
The WmART package is automatically installed when you install Integration Server. You
should not have to manually reload the WmART package.
If the connections and adapter services of an adapter are defined in different packages, then:
A package that contains the connections must depend on the adapter package.
Packages that contain adapter services must depend on their associated connection package.
Keep connections for different adapters in separate packages so that you do not create
interdependencies between adapters. If a package contains connections for two different
adapters, and you reload one of the adapter packages, the connections for both adapters will
reload automatically.
Integration Server will not allow you to enable a package if it has a dependency on another
package that is disabled. That is, before you can enable your package, you must enable all
packages on which your package depends. For information about enabling packages, see
“Enabling and Disabling Packages” on page 29.
Integration Server will allow you to disable a package even if another package that is enabled
has a dependency on it. Therefore, you must manually disable any user-defined packages that
have a dependency on the adapter package before you disable the adapter package.

Enabling and Disabling Packages
The WmOAAdapter package is enabled by default. You must manually enable all other packages.
To prevent Integration Server from loading a particular package at startup, you must manually
disable that package.

Enabling Packages
To enable a package
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1. Open Integration Server Administrator.
2. In the Packages menu of the navigation area, click Management.
3. Click No in the Enabled column. The server displays a

and Yesin the Enabled column.

Note:
Enabling an adapter package will not cause its associated user-defined packages to be
reloaded. For information about reloading packages, see “Loading, Reloading, and Unloading
Packages” on page 30.
Note:
Before you manually enable a user-defined package, you must first enable its associated
adapter package ( WmOAAdapter ).

Disabling Packages
To disable a package
1. Open Integration Server Administrator.
2. In the Packages menu of the navigation area, click Management.
3. Click Yes in the Enabled column for the package that you want to disable. The server issues
a prompt to verify that you want to disable the package. Click OK to disable the package.
When the package is disabled, the server displays No in the Enabled column.
A disabled adapter will remain disabled until you explicitly enable it using Integration Server
Administrator.
Disabled packages are not listed in Designer.

Loading, Reloading, and Unloading Packages
Recall that if user-defined packages are properly configured with a dependency on the adapter
package (as described in “Package Dependency Requirements and Guidelines” on page 29), at
startup Integration Server automatically loads or reloads all packages in the proper order: the
WmART package first, the adapter package next, and the node packages last. You should not need
to manually reload the WmART package.

Reloading Packages Manually
Reloading a user-defined package will not cause its associated adapter package to be reloaded.
You can reload adapter packages and user-defined packages from any of the following:
In Integration Server Administrator, click the Reload icon on the Management window.
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In Designer, right-click the package and select the Reload Package option from the menu.

Unloading Packages
At shutdown, Integration Server unloads packages in the reverse order in which it loaded them
(assuming the dependencies are correct), as follows:
1. Node packages.
2. Adapter package.
3. WmART package.

Setting Package Dependencies
You set package dependencies if a given package needs services in another package to load before
it can load. For example, any packages you create for Oracle Apps Adapter services or notifications
should identify webMethods Oracle Applications Adapter package ( WmOAAdapter ) as a package
dependency because they require services in the WmOAAdapter to load first. Use the following
guidelines:
Set package dependencies from the adapter service or notification package to the package
containing the connection if you configure a connection in one package and the adapter services
or notifications in another package. That is, the package that contains the connection should
load before the adapter service or notification package.
When you set this package dependency, it ensures that if you reload the connection package,
the adapter service or notification package will automatically reload. However, if someone
disables the connection package and then re-enables it, the adapter service or notification
package will not reload automatically. In this scenario, you must reload the adapter or
notification package.
If both the connection and adapter services or notifications are in the same package, then no
dependencies need to be set.
In general, packages containing connections should have a dependency set to the adapter
package itself. That is, the adapter service or notification package should depend on the adapter
connection package, which should depend on the adapter package. Similarly, if the adapter
services or notifications are in the same package as the connections, the only dependency that
you need to set is between the adapter connection package and the adapter package.
For more information about setting package dependencies, see the webMethods Service Development
Help for your release.

Group Access Control
To control which development group has access to which adapter services, use access control lists
(ACLs). You can use ACLs to prevent one development group from inadvertently updating the
work of another group, or to allow or deny access to services that are restricted to one group but
not to others.
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For general information about assigning and managing ACLs, see the webMethods Service
Development Help for your release.

Oracle Apps Adapter in a Clustered Environment
What is webMethods Integration Server Clustering?
Clustering is an advanced feature of Integration Server that substantially extends the reliability,
availability, and scalability of Integration Server.
Clustering accomplishes this by providing the infrastructure and tools to deploy multiple Integration
Servers as if they were a single virtual server and to deliver applications that leverage that
architecture. Because this activity is transparent to the client, clustering makes multiple servers
look and behave as one.
Integration Server supports the caching and clustering functionality provided by Terracotta.
Caching and clustering are configured at the Integration Server level and Oracle Apps Adapter
uses the caching mechanism that is enabled on Integration Server. Oracle Apps Adapter does not
explicitly implement any clustering or caching beyond what is already provided by Integration
Server.
When Integration Server uses Terracotta as its caching provider, you must configure Oracle Apps
Adapter to use webMethods Integration Server Scheduler to support polling notifications. For
information about executing polling notifications using the Integration Server Scheduler, see
“Configuring Polling Notifications When Integration Server Uses Terracotta ” on page 36.
With clustering, you get the following benefits:
Load balancing. This feature, provided automatically when you set up a clustered environment,
allows you to spread the workload over several servers, thus improving performance and
scalability.
Failover support. Clustering enables you to avoid a single point of failure. If a server cannot
handle a request, or becomes unavailable, the request is automatically redirected to another
server in the cluster.
Note:Integration Server clustering redirects HTTP and HTTPS requests, but does not redirect
FTP or SMTP requests.
Scalability. You can increase your capacity even further by adding new machines running
Integration Server to the cluster.
For details on Integration Server clustering, see the webMethods Integration Server Clustering Guide
for your release.

Configuring Oracle Apps Adapter
When you use Oracle Apps Adapter to configure adapter services, you must:
Ensure that each Integration Server in the cluster contains an identical set of packages.
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Disable the redirection capability for certain predefined administrative services.

Replicating Packages to Integration Servers
Every Integration Server in the cluster should contain an identical set of packages that you define
using Oracle Apps Adapter; that is, you should replicate Oracle Apps Adapter services and the
connections they use.
Note:
You do not replicate the polling notifications.
To ensure consistency, we recommend that you create all packages on one server, and replicate
them to the other servers. If you allow different servers to contain different services, you might
not derive the full benefits of clustering. For example, if a client requests a service that resides in
only one server, and that server is unavailable, the request cannot be successfully redirected to
another server.
For information about replicating packages, see the chapter on managing packages in the webMethods
Integration Server Administrator’s Guide for your release.

Disabling the Redirection of Administrative Services
As mentioned in “What is webMethods Integration Server Clustering?” on page 32, a server that
cannot handle a client's service request can automatically redirect the request to another server in
the cluster. However, Oracle Apps Adapter uses certain predefined administrative services that
you should not allow to be redirected. These services are used internally when you configure the
adapter. If you allow these services to be redirected, your configuration specifications might be
saved on multiple servers, which is an undesirable result. For example, if you configure two Oracle
Apps Adapter services, one might be stored on one server, while the other one might be stored
on another server. Remember that all adapter services must reside on all Integration Servers in
the cluster.
To disable the redirection of administrative services:
1. Shut down Integration Server. For the procedure to do this, see the webMethods Integration
Server Administrator’s Guide for your release.
2. Open the following file:
Integration Server_directory \config\redir.cnf
3. Edit the file by adding the following line:
<value name="wm.art">false</value>

4. Save the file and restart Integration Server.
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Clustering Considerations and Requirements
Note:
The following sections assume that you have already configured the Integration Server cluster.
For details about clustering, see the webMethods Integration Server Clustering Guide for your
release.
The following considerations and requirements apply to Oracle Apps Adapter in a clustered
environment.

Requirements for Each Integration Server in a Cluster
The following table describes the requirements of each Integration Server in a given cluster:
All Integration Servers in a
given cluster must have
identical...

For example...

Integration Server versions

All Integration Servers in the cluster must be the same version,
with the same service packs and fixes applied.

Adapter packages

All adapter packages on one Integration Server should be
replicated to all other Integration Servers in the cluster.

Adapter versions

All adapters of the same type (for example, Oracle Applications
) in the cluster must be the same version number.

Adapter connections

If you configure a connection to the database, this connection
must appear on all servers in the cluster so that any Integration
Server in the cluster can handle a given request identically.
If you plan to use connection pools in a clustered environment,
see “Considerations When Configuring Connections with
Connection Pooling Enabled” on page 35.

Adapter services

If you configure a specific Insert adapter service, this same adapter
service must appear on all servers in the cluster so that any
Integration Server in the cluster can handle the request identically.
If you allow different Integration Servers to contain different
services, you might not derive the full benefits of clustering. For
example, if a client requests a service that resides on only one
server, and that server is unavailable, the request cannot be
successfully redirected to another server.

For information about replicating adapter packages, connections, and adapter services across
multiple Integration Servers in a cluster, see “Replicating Packages to Integration Servers” on
page 33.
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Considerations When Installing Oracle Apps Adapter Packages
For each Integration Server in the cluster, use the standard Oracle Apps Adapter installation
procedures for each machine, as described in “Installing Oracle Apps Adapter ” on page 23.

Considerations When Configuring Connections with Connection Pooling Enabled
When you configure a connection that uses connection pools in a clustered environment, be sure
that you do not exceed the total number of connections that can be opened simultaneously for
that database.
For example, if you have a cluster of two Integration Servers with a connection configured to a
database that supports a maximum of 100 connections opened simultaneously, the total number
of connections possible at one time must not exceed 100. This means that you cannot configure a
connection with an initial pool size of 100 and replicate the connection to both servers, because
there could be possibly a total of 200 connections opened simultaneously to this database.
In another example, consider a connection configured with an initial pool size of 10 and a maximum
pool size of 100. If you replicate this connection across a cluster with two Integration Servers, it is
possible for the connection pool size on both servers to exceed the maximum number of database
connections that can be open at one time.
For information about configuring connections for Oracle Apps Adapter, see “Configuring Adapter
Connections” on page 41.
For more general information about connection pools, see the webMethods Integration Server
Administrator’s Guide for your release.

Scheduling Service Invocations in a Clustered Environment
Services configured from Oracle Apps Adapter can be invoked within a flow that is scheduled
from the webMethods scheduler. This is a useful process to invoke Oracle Applications
-to-Integration Server query services and Integration Server-to- Oracle Applications Error SQL
services.
In a clustered environment, it is important that you do not schedule the same query service using
the same query parameters on multiple cluster servers. Doing this can produce duplicate data.
The predefined transaction services were designed to prevent a single document being retrieved
multiple times. However, it is up to you to ensure that user-defined adapter services do not retrieve
a document more than once.
For example, assume you have two cluster servers: Server A and Server B. You schedule a
PurchaseOrderNew service to be invoked every 15 minutes. This service is configured to retrieve all
new purchase orders for Company A. Assume that you also schedule the same service on Server B.
Because the scheduler is not aware of clustering, both services might execute simultaneously,
which would cause duplicate purchase orders to be retrieved for Company A. The following figure
illustrates this concept.
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Step

Description

1

Scheduler A invokes a service to retrieve new purchase orders.

2

Server A begins processing the new purchase orders.

3

Scheduler B invokes a service to retrieve the new purchase orders.

4

Server B receives purchase orders already retrieved by Server A.

5

Server A acknowledges its purchase orders.

6

Server B acknowledges its purchase orders.

If you need to schedule PurchaseOrderNew, PurchaseOrderChange, InvoiceOutbound, or AdvancedShipNotice
services on multiple servers, you must ensure that the query parameters on each server will return
unique records because Oracle Applications will return the same records for the above transactions
until they are acknowledged. The above example would work if Server A was pulling new purchase
orders for Company A, while Server B was pulling new purchase orders for Company B. This must
also be considered for any custom transaction that requires an acknowledgement.

Configuring Polling Notifications When Integration Server Uses
Terracotta
Oracle Apps Adapter uses webMethods Integration Server Scheduler to support polling
notifications. On enabling a polling notification, a new Integration Server scheduled task is created,
which polls the backend resource at the given interval. Do not manually edit or change scheduled
tasks. Each polling notification creates an Integration Server scheduled task. When a notification
is disabled, the scheduled task in Integration Server is removed.
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Before Configuring Polling Notifications to Execute via Scheduled Tasks
Before configuring your existing polling notifications to execute via scheduled tasks, ensure that:
All polling notifications for which you want to use scheduled task functionality are disabled.
Note:
Enabling or disabling the polling notification node on one Integration Server node in the
cluster will enable or disable the polling notification node on all Integration Server nodes
in the cluster.
For instructions on disabling notifications, see “Managing Polling Notifications” on page 78.
Each notification is present in all cluster nodes at all times.
The Overlap function for the polling notifications is disabled.
Polling notifications names do not exceed 400 characters.
The value of the Integration Server configuration parameter watt.server.scheduler.threadThrottle
should not be lower than the number of total polling notifications and scheduled tasks. By
default the value is 75% of the total threads.
The IS Internal functional alias (specified on the Settings > JDBC Pools screen) is configured
with a database.

Configuring Polling Notifications to Execute via Scheduled Tasks
To configure polling notifications to execute via scheduled tasks
1. Start Integration Server and log into Integration Server Administrator.
2. From Integration Server Administrator, select Settings > Extended > Edit Extended Settings.
3. Enable the use of scheduled tasks for polling notifications by setting
watt.pkg.art.pollingnotification.scheduler=true

If the parameter is not shown, add it.
4. Specify the adapter package in the watt.pkg.art.pollingnotification.scheduler.adapters
configuration parameter: watt.pkg.art.pollingnotification.scheduler.adapters=WmOAAdapter
If the parameter is not shown, add it.
5. Make scheduled notification tasks visible in the Server > Scheduler page by setting
watt.server.scheduler.notificationtask.display=true

If the parameter is not shown, add it.
Note:
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Configuring this property is required only for debugging or for editing the polling notification
schedule interval.
6. Click Save Changes.
Keys for the new parameters appear in the Extended Settings.
7. Restart Integration Server.
8. Enable all polling notifications. For instructions, see “Managing Polling Notifications” on
page 78.
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Overview
The following sections provide instructions for configuring and managing Oracle Apps Adapter
connections. For more information about how connections work, see “Adapter Connections” on
page 39.

Before Configuring or Managing Adapter Connections
To prepare to configure or manage adapter connections
1. Install Integration Server and Oracle Apps Adapter on the same machine. See “Installing Oracle
Apps Adapter ” on page 24 for details.
2. Make sure that you have Integration Server administrator privileges so that you can access
the Oracle Apps Adapter administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.
3. Start Integration Server and Integration Server Administrator, if they are not already running.
4. Using Integration Server Administrator, make sure the Oracle Applications package is enabled.
See “Enabling Packages” on page 29 for instructions.
5. Using Designer, create a user-defined package for each connection you plan to configure. See
“ Oracle Apps Adapter Package Management” on page 28 for more information about
managing packages for the adapter.

Setting Up Your Adapter's Environment
Oracle Apps Adapter requires a JDBC driver (typically classes12.zip) that has the same version
as your Oracle database.
The Software AG Installer enables you to either copy the file at install time, or to copy the file later.
See “Installing Oracle Apps Adapter ” on page 24 for details. If you did not perform that step at
install time, you will need to do it before configuring an adapter connection.
Ensure that the classes are correct for the version of the Oracle DBMS you are using.
To prepare to configure or manage adapter connections
1. Locate the file classes12.zip. Typically it is available on the Oracle server.
2. Copy the file to the following directory:
Integration Server_directory \packages\ WmOAAdapter\code\jars
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Configuring Adapter Connections
When you configure Oracle Apps Adapter connections, you create a new connection and specify
information that Integration Server uses to connect and log into an Oracle Applications server.
You configure Oracle Apps Adapter connections using Integration Server Administrator.
Note:
If you are using predefined transaction services, they use a specific preconfigured connection.
You only need to edit the connection and specify the database connection information specific
to your system. See “Editing Adapter Connections” on page 46 for instructions. For more
information about using connections with predefined transaction services, see the webMethods
Oracle Applications Predefined Transaction Services Installation and User's Guide for the version of
Oracle Applications with which you are using the adapter.
To configure a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. On the Connections screen, click Configure New Connection.
3. On the Connection Types screen, click Oracle Apps Adapter Connection to display the
Configure Connection Type screen.
4. In the Oracle Apps Adapter section, provide values for the following fields.
Parameter

Description/Action

Package

The package in which to configure the connection.
You must create the package using Designer before you can specify
it for this parameter. For general information about creating packages,
see the webMethods Service Development Help for your release.
Note:
Configure the connection in a user-defined package rather than in
the adapter's package. See “ Oracle Apps Adapter Package
Management” on page 28 for other important considerations when
creating packages for use with Oracle Apps Adapter.

Folder Name

The folder in which to configure the connection.

Connection Name

The name you want to give the connection. Connection names cannot
have spaces or use special characters reserved by Integration Server,
or Designer. For more information about the use of special characters
in package, folder, and element names, see the webMethods Service
Development Help for your release.
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5. In the Connection Properties section, provide values for the following fields:
Parameter

Description/Action

Oracle Apps Release The version of the Oracle Applications server to which you are
connecting.
version
Database Server
Host

The host name of the Oracle Applications database to which you are
connecting.

Database Port
Number

The port number of the Oracle Applications database.

Database Name

The name of the Oracle Applications database.

Database User Name The user name that Integration Server must use to log into the Oracle
Applications database. APPS is the only user name Oracle Apps
Adapter supports.
Database Password The password that Integration Server must user to log into the Oracle
Applications database.
Retype Database
Password

Confirms the password you specified in Database Password.

Local/XA Transaction The type of transaction support that the connection provides. Select
the following transaction type:
Control
LOCAL_TRANSACTION: The connection does not automatically
commit transactions. You can manually define the transactions, or the
Integration Server transaction manager will manage it for you. See
“Built-In Transaction Management Services” on page 99 for
instructions on managing transactions manually.
DataSource Class
Name

The name of the JDBC driver's DataSource class name. Only the Oracle
Thin JDBC Driver is supported:
oracle.jdbc.pool.OracleDataSource

Network protocol

A standard Oracle Applications DataSource property to indicate the
name of the network protocol that the connection will use when
connecting to the database.
Leave this parameter blank.

Other properties

Enables you to provide additional JDBC driver DataSource properties
for the Oracle Thin JDBC Driver. The following property is supported:
driverType=thin

6. In the Connection Management Properties section, provide values for the following fields:
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Parameter

Description/Action

Enable Connection
Pooling

Enables the connection to use connection pooling.
See “Connection Pools” on page 16 for more information about
connection pooling.
Note:
If you plan to enable connection pooling in a clustered environment,
consider the connection pool size. For details, see “Considerations
When Configuring Connections with Connection Pooling
Enabled” on page 35.

Minimum Pool Size

If connection pooling is enabled, this field specifies the number of
connections to create when the connection is enabled. The adapter
will keep open the number of connections you configure here
regardless of whether these connections become idle.

Maximum Pool Size If connection pooling is enabled, this field specifies the maximum
number of connections that can exist at one time in the connection
pool.
Pool Increment Size If connection pooling is enabled, this field specifies the number of
connections by which the pool will be incremented if connections are
needed, up to the maximum pool size.
Block Timeout
(msec)

If connection pooling is enabled, this field specifies the number of
milliseconds that Integration Server will wait to obtain a connection
with the database before it times out and returns an error.
For example, you have a pool with Maximum Pool Size of 20. If you
receive 30 simultaneous requests for a connection, 10 requests will be
waiting for a connection from the pool. If you set the Block Timeout
to 5000, the 10 requests will wait for a connection for 5 seconds before
they time out and return an error. If the services using the connections
require 10 seconds to complete and return connections to the pool,
the pending requests will fail and return an error message stating that
no connections are available.
If you set the Block Timeout value too high, you might encounter
problems during error conditions. If a request contains errors that
delay the response, other requests will not be sent. Tune this setting
in conjunction with the Maximum Pool Size to accommodate such
bursts in processing.

Expire Timeout
(msec)

If connection pooling is enabled, this field specifies the number of
milliseconds that an inactive connection can remain in the pool before
it is closed and removed from the pool.
The connection pool will remove inactive connections until the number
of connections in the pool is equal to the Minimum Pool Size. The
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Parameter

Description/Action
inactivity timer for a connection is reset when the connection is used
by the adapter.
If you set the Expire Timeout value too high, you might have a
number of unused inactive connections in the pool. This consumes
local memory and a connection on your backend resource. This could
have an adverse effect if your resource has a limited number of
connections.
If you set the Expire Timeout value too low, performance could
degrade because of the increased activity of creating and closing
connections. This setting should be tuned in conjunction with the
Minimum Pool Size to avoid excessive opening/closing of connections
during normal processing.

Startup Retry Count The number of times that the system should attempt to initialize the
connection pool at startup if the initial attempt fails. The default is 0.
Startup Backoff
Timeout (sec)

The number of seconds that the system should wait between attempts
to initialize the connection pool.

7. Click Save Connection.
By default, when you configure a connection, it is not enabled. For information about enabling
connections, see “Enabling Adapter Connections” on page 45.

Dynamically Changing a Service's Connection at Run Time
You can run a service using a connection other than the default connection that was associated
with the service when the service was created. To override the default, you must code your flow
to pass a value through the pipeline into a service's $connectionName field.
For example, you could design a flow for an international company that has multiple geographically
separated production systems. With the run-time connection switching capability, you do not
need to configure the same service multiple times. Instead, all you need do is map the appropriate
value of a connection name to the $connectionName field in the pipeline and pass it along to the
services.
Keep in mind these restrictions when using dynamic connections:
Both connections - the default and override - must be to Oracle Applications instances accessed
with the APPS user name.
The connection with which you override the default (that is, the value provided for
$connectionName) must be configured to use the same transaction type as the default
connection.
The $connectionName field is present only in services created with Designer.
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Predefined transaction services do not have $connectionName in their service signatures. However,
users can use an Integration Server map step to place this value in the pipeline before the service
is invoked.
For more information, see “Changing the Connection Associated with an Adapter Service at Run
Time” on page 17.

Enabling Adapter Connections
You enable connections using Integration Server Administrator. An Oracle Apps Adapter connection
must be enabled before you can configure an adapter service using the connection, or before an
adapter service can use the connection at run time.
Note:
When you reload a package that contains enabled connections, the connections will automatically
be enabled when the package reloads. If the package contains connections that are disabled,
they will remain disabled when the package reloads.
To enable a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. On the Connections screen, click No in the Enabled column for the connection you want to
enable.
Integration Server Administrator enables the adapter connection and displays
the Enabled column.

and Yes in

Viewing Adapter Connection Parameters
You can view a connection's parameters from Integration Server Administrator, or Designer.

Viewing Connection Parameters Using Integration Server
Administrator
To view the parameters for a connection using Integration Server Administrator
1. In the Adapters menu in the Integration Server Administrator area, click Oracle Apps Adapter.
When using the adapter with Integration Server 8.0 and later, you can sort and filter the list
of connections that appears on the Connections screen.
To sort information on the Connections screen, click the Up and Down arrows at the top
of the column you want to sort.
To filter the list of connections:
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1. On the Connections screen, click Filter Connections.
2. Type the criterion by which you want to filter into the Filter criteria box. Filtering is
based on the node name, not the connection alias. To locate all connections containing
specific alphanumeric characters, use asterisks (*) as wildcards. For example, if you
want to display all connections containing the string "abc", type *abc* in the Filter
criteria box.
3. Click Submit. The Connections screen displays the connections that match the filter
criteria.
4. To re-display all connections, click Show All Connections.
The Connections screen appears, listing all the current connections. You can control the number
of connections that are displayed on this screen. For more information, see “Controlling
Pagination” on page 22.
2. On the Connections screen, click the

icon for the connection you want to see.

The View Connection screen displays the parameters for the connection. For descriptions of
the connection parameters, see “Configuring Adapter Connections” on page 41.
3. Click Return to Oracle Apps Adapter Connections to return to the main connections screen.

Viewing Connection Parameters Using Designer
To view the parameters for a connection using Designer
1. From the Designer navigation area, open the package and folder in which the connection is
located.
2. Click the connection you want to view.
The parameters for the connection appear in the Connection Information tab. For descriptions
of the connection parameters, see “Configuring Adapter Connections” on page 41.

Editing Adapter Connections
You edit connections using Integration Server Administrator. If the login information for an Oracle
Applications server changes, you must update your connection to reflect the changes.
Note:
You can edit a connection only when it is disabled, as described in “Disabling Adapter
Connections” on page 48.
To edit a connection
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1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. From the navigation area, select Connections.
3. Make sure that the connection is disabled before editing it. See “Disabling Adapter
Connections” on page 48 for instructions.
4. On the Connections screen, click the

icon for the connection you want to edit.

The Edit Connection screen displays the current parameters for the connection. Update the
connection's parameters by typing or selecting the values you want to specify.
For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 41.
5. Click Save Changes to save the connection and return to the Connections screen.
6. Enable the connection when you are ready to use it. See “Enabling Adapter Connections” on
page 45 for instructions.

Copying Adapter Connections
You copy connections using Integration Server Administrator. You can copy an existing Oracle
Apps Adapter connection to configure a new connection with the same or similar connection
properties without having to type all of the properties for the new connection.
To copy a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. From the navigation area, select Connections.
3. On the Connections screen, click the Copy icon for the connection you want to copy.
The Copy Connection screen displays the current parameters for the connection you want to
copy. Name the new connection, specify a Package Name and Folder Name, and edit any
connection parameters as needed by typing or selecting the values you want to specify.
Note:
When you copy a connection, the new connection does not save the password of the original
connection. You must enter and then retype the password before you can save the new
connection.
For descriptions of the connection parameters, see “Configuring Adapter Connections” on
page 41.
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4. Click Save Connection Copy to save the connection and return to the Connections screen.

Deleting Adapter Connections
You delete connections using Integration Server Administrator. If you no longer want to use a
particular Oracle Apps Adapter connection, you can delete it by following the instructions in this
section.
Note:
You can delete a connection only if it is disabled, as described in “Disabling Adapter
Connections” on page 48.
Important:
If you delete an Oracle Apps Adapter connection, any adapter services or adapter notifications
that are defined to use the connection will no longer work. You cannot change which connection
an adapter service uses after the service is configured; however, you can change the parameters
for an existing connection. See “Editing Adapter Connections” on page 46 for instructions.
To delete a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. On the Connections screen, make sure that the connection is disabled before deleting. See
“Disabling Adapter Connections” on page 48 for instructions.
3. On the Connections screen, click

for the connection you want to delete.

Integration Server deletes the adapter connection.

Disabling Adapter Connections
You disable connections using Integration Server Administrator. An Oracle Apps Adapter
connection must be disabled before you can edit or delete it.
To disable a connection
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. On the Connections screen, click Yes in the Enabled column for the connection you want to
disable.
The adapter connection becomes disabled and you see a No in the Enabled column.
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Overview
The following sections provide instructions for importing and exporting Oracle Apps Adapter
transaction definitions, and for configuring and managing those transaction definitions. For more
information about how transaction definitions work, see “Transaction Definitions” on page 18.
Additionally, this chapter provides a detailed explanation of SQL trees, and describes how to use
them when configuring or updating transaction definitions in “Working with SQL Trees in Oracle
Applications -to-Integration Server Transactions” on page 59.

Before Working with Transaction Definitions
To prepare to import, export, configure, or manage transaction definitions
1. Start Integration Server and Integration Server Administrator, if they are not already running.
2. Make sure that you have Integration Server administrator and developer privileges so that
you can access Oracle Apps Adapter administrative and Designer screens. For information
about setting user privileges, see the webMethods Integration Server Administrator’s Guide for
your release.
3. Using Integration Server Administrator, make sure the WmOAAdapter package is enabled.
See “Enabling Packages” on page 29 for instructions.

Importing Transaction Definitions
You can use the procedure in this section to import the following types of transaction definitions
into the repository or shared cache:
Sample transaction definitions
If you plan to use the sample transaction definitions to configure adapter services, you must
first import the transaction definitions. The sample transaction definitions are located in the
following directory:
Integration Server_directory \packages\WmOAAdapter\sampleTxns
Note:
The sample transaction definitions are the same transaction definitions that were provided
with Oracle Apps Adapter.
Transaction definitions used by the predefined transaction services
If you plan to use the predefined transaction services, you do not have to import their associated
transaction definitions. This is because the transaction definitions that were installed as part
of the predefined transaction services are loaded automatically by Integration Server at startup.
For the location of the transaction definition files, see the webMethods Oracle Applications
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Predefined Transaction Services Installation and User's Guide for the version of Oracle Applications
with which you are using the adapter.
Transaction definitions that have previously been exported to files
Transaction definitions that have been modified or custom built
After you import transaction definitions, they are stored in the repository or shared cache.
You must make sure that the files you want to import are located in the following directory:
Integration Server_directory \packages\WmOAAdapter\exchange
Note:
Any .txp files in the \exchange directory are automatically imported when Integration Server
starts or when the WmOAAdapter package is reloaded.
Transaction definition files must use the .txp file extension.
You can import transaction definition files in the \exchange folder from Integration Server
Administrator or from Designer. Integration Server Administrator lets you import one transaction
definition file at a time; using Designer you can import all transaction definition files.

Importing Transaction Definitions One at a Time Using
Integration Server Administrator
To import transaction definitions one at a time using Integration Server Administrator
1. In the Adapters menu in Integration Server Administrator navigation area, click Oracle Apps
Adapter.
2. On the Connections screen, in the Oracle Apps Adapter menu in the navigation area, click
Transaction Mgmt.
3. Click Transaction Import.
4. Select a file from the Import Files list.
If no files are listed, ensure that the transaction file to import is in the exchange directory.
5. From the Import to Oracle Applications Release list, select the release of Oracle Applications
for which you are importing transaction definitions. The list defaults to the release from which
the transaction definitions were exported.
6. Select the transactions you want to import, as follows:
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For this parameter...

Specify...

Import this
transaction

Whether you want to import the transaction.

Import Name

The name you want the transaction to have in your system. The default
is the name as it is specified in the import file.

Overwrite Existing

Whether you want to overwrite transactions that are named the same
as the import name.

Click Set to select all transactions to import. Click Clear to de-select
all transactions selected for import.

To overwrite all transactions, click Set. To de-select all transactions,
click Clear.
7. Click Import. The adapter displays the Oracle Applications Transaction Import Results screen,
which lists the status of the transaction definition you imported.
8. During adapter startup or reload, transaction files in the Integration Server_directory
\packages\WmOAAdapter\exchange directory are automatically imported. This could overwrite
any changes you have made in the repository or shared cache, so you must verify that the
transaction definition files in the Integration Server_directory \packages\WmOAAdapter\exchange
directory are updated. If there are any transaction definitions you do not want overwritten in
the repository or shared cache, move them to another directory on your system.

Importing All Transaction Definitions Using Designer
To import all transaction definitions using Designer
1. Open Designer if it is not already running. For the procedure for this step, see the webMethods
Service Development Help for your release.
2. From the Designer navigation area, open the WmOAAdapter package and folder in which the
connection is located. Typically this is the pub>adapter>wmoa folder.
3. Double-click ImportAllTransactions.
4. Click the

icon. Examine the Service Results pane (in Designer) to see the import status.

Exporting Transaction Definitions
You can export transaction definitions to files to back them up or to prepare to transfer them to a
different installation of Oracle Apps Adapter. You export transaction definitions from the repository
or shared cache. Exported files are saved to the Integration Server_directory \packages\ Oracle
Applications \exchange\export directory.
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To export transaction definitions
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Export.
4. Select the release of the Oracle Applications transactions you want to export.
Oracle Apps Adapter displays the Oracle Applications Transaction Export screen, which
lists all available transaction definitions for the release of Oracle Applications you selected.
Use this screen to specify which transaction definitions you want to export.
5. Provide information about the export file, as follows:
For this parameter...

Specify...

Oracle Apps Release The release of Oracle Applications from which you want to export
transaction definitions.
Export File

The name of the export file. If the file does not currently exist, the
adapter will create it for you.
You do not have to specify the .txp file extension; it is supplied for
you automatically.

Overwrite Existing
File

Whether to overwrite an existing file if there is already a file with the
name you specified in Export File.

Create Host

The machine on which Integration Server is running.
If you want to change the name of the host for security purposes, type
a new name in the field.

Description

A description to identify the contents of the file.

6. Select the transactions you want to export. To select all transactions to export, click Set. To
de-select all transactions selected for export, click Clear.
7. Click Create File. The export file is created in the Integration Server_directory
\packages\WmOAAdapter\exchange\export directory.
8. When you are ready to import the exported transaction definitions, move the export file that
is in the Integration Server_directory \packages\WmOAAdapter\exchange\export directory to the
Integration Server_directory \packages\WmOAAdapter\exchange\ directory.
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Creating Integration Server-to- Oracle Applications Transaction
Definitions
Perform the following procedure to create transaction definitions that insert data from Integration
Server into Oracle Applications tables.
To create a new Integration Server-to- Oracle Applications transaction definition
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Configuration.
4. Select the Oracle Applications release from the list.
5. Select IS-to-Oracle in the Transaction Type field if it is not currently selected.
6. Click Add. The adapter displays the New Transaction screen.
7. Specify a name for the transaction in the Transaction Name field.
8. Click Submit.
9. Enter the name of an open interface table in the Table Name field. If you want to specify that
this table is required, check the Required option. Then click Submit.
Repeat this step for each table you want the transaction to have access to. If you want to add
a new table but a table is currently selected, click Cancel to de-select the current table.
Each table added appears in the Current Tables area. If you want to delete a table from the
list, select it and then click Delete Table.
10. To specify SQL to check for errors that occurred during the import process, click Edit Error
SQL. The adapter displays the Error Service SQL for transaction screen. Add the SQL in
the Error SQL field, and then click Submit.
To expose an SQL input parameter as a service input in Designer, enclose the input parameter
within an ampersand (&) and an asterisk (*) (for example, &varname*). Stored procedure input
parameters are exposed as service inputs in Designer.
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Creating Oracle Applications -to-Integration Server Transaction
Definitions
Perform the following procedure to create transaction definitions that select data from Oracle
Applications and delivers it to webMethods Integration Server.
For information about how SQL trees are defined in Oracle Applications -to-Integration Server
transaction definitions, see “Working with SQL Trees in Oracle Applications -to-Integration Server
Transactions” on page 59.
Note:
You cannot combine stored procedures with SQL queries in an Oracle Applications -to-Integration
Server transaction definition. Use only stored procedures or SQL trees.
To create a new Oracle Applications -to-Integration Server transaction definition
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Configuration.
4. Select the Oracle Applications release from the list.
5. Select Oracle-to-IS in the Transaction Type field.
6. Click Add. The adapter displays the New Transaction screen.
7. Specify a name for the transaction in the Transaction Name field.
8. Click Submit. The adapter displays the Edit Transaction screen.
9. Specify the top-level alias for the transaction, as follows:
a. Enter the alias name in the Alias Name field.
b. In the SQL field, enter or edit the SQL statement that performs the query, or enter the name
of a stored procedure to execute:
To expose an SQL input parameter as a service input in Designer, enclose the input
parameter within an ampersand (&) and an asterisk (*) (for example, &varname*).
Stored procedure input parameters are exposed as service inputs in Designer.
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To call a stored procedure, enter the stored procedure name in the format
schema.package.procname. If the stored procedure is not located in a package, you do not
have to enter the schema and package names.
c. Click Submit.
10. To specify a child for an alias, select the alias to which you want to add a child and click Next
Level. If you want to add a new sibling alias but an alias is currently selected, click Cancel to
de-select the current alias. Then specify the alias information, as follows:
a. Enter the alias name in the Alias Name field.
b. In the SQL field, enter or edit the SQL statement that performs the query.
c. To specify the relationship of the current alias to its parent alias, enter it in the Relations
field.
If you are creating an alias with a SELECT statement, Relations defines the WHERE clause
and join parameters. Enter the values as follows:
COLUMN = PARENT_ALIAS.COLUMN AND COLUMN2 = PARENT_ALIAS.COLUMN2 …

d. Click Submit.
11. To add SQL to acknowledge the transaction, click Edit Ack SQL. The adapter displays the
Acknowledgement Service SQL for transaction screen. Add the SQL in the
Acknowledgement SQL field, and then click Submit.
Note:
The purpose of an Acknowledgement SQL is to prevent the query from retrieving the same
piece of data again.
12. Repeat the previous step for each alias you are adding.

Editing Integration Server-to- Oracle Applications Transaction
Definitions
Note:
You should be familiar with the Oracle Applications data schema before editing transaction
definitions. Please refer to your Oracle Applications technical documentation or consult your
Oracle Applications administrator before editing the transaction definitions.
To edit transaction definitions
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
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2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Configuration.
4. Select the Oracle Applications release from the list.
5. Select IS-to-Oracle in the Transaction Type field.
6. Select the transaction definition you want to edit, and then click Edit. The adapter displays
the Edit transaction Transaction screen.
7. Update the transaction definition as follows:
To add a new table, enter the table name in the Table Name field, indicate whether the
table is required, and then click Submit.
To delete a table, select the table from the list of current tables, and then click Delete Table.
To change the error log SQL, click Edit Error SQL. The adapter displays the Error Service
SQL For transaction screen. Update the SQL in the Error SQL field, and then click Submit.
The error log SQL is SQL code that checks for errors that occur during the import process.
8. When you are finished updating the transaction definition, click Back.
Important:
If you change a transaction definition, you must refresh any services that were created from
that transaction. Refreshing the services causes Integration Server to update the information
in its cache for the affected services. For more information about updating the information
in Designer, see the webMethods Service Development Help for your release.

Editing Oracle Applications -to-Integration Server Transaction
Definitions
For information about how SQL trees are defined in Oracle Applications -to-Integration Server
transaction definitions, see “Working with SQL Trees in Oracle Applications -to-Integration Server
Transactions” on page 59.
Note:
You should be familiar with the Oracle Applications data schema before editing transaction
definitions. Please see your Oracle Applications technical documentation or consult your Oracle
Applications administrator before editing the transaction definitions.
To edit transaction definitions
1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
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2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Configuration.
4. Select the Oracle Applications release from the list.
5. Select Oracle-to-IS in the Transaction Type field.
6. Select the transaction definition you want to edit from the Current Oracle-to-IS Transactions
list.
7. Click Edit.
8. Update the transaction definition as follows:
To update an existing alias, select the alias you want to edit from Current SQL Tree for:
transaction . If you want to edit a child alias, drill down to the child alias by selecting the
parent alias and clicking Next Level. Update the Alias Name, SQL, and Relations (if
applicable) and then click Submit.
To delete an alias, select the alias fromCurrent SQL Tree for: transaction and then click
Delete Alias.
To add a new alias, select the alias to which you want to add a child alias and then click
Next Level. Enter the Alias Name, SQL, and Relations information and then click Submit.
9. When you are finished updating the transaction definition, click Previous Level until you
return to the Transaction Configuration screen.
Important:
If you change a transaction, you must refresh any services that were created from that
transaction. Refreshing the services causes Integration Server to update the information in
its cache for the affected services. For more information about updating the information in
Designer, see the webMethods Service Development Help for your release.

Deleting Transaction Definitions
If you no longer need an Oracle Applications transaction definition, you can delete it from the
repository or shared cache.
Important:
Use caution when deleting transaction definitions. Deleting a transaction definition renders
their associated adapter services useless.
To delete a transaction definition
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1. In the Adapters menu in the Integration Server Administrator navigation area, click Oracle
Apps Adapter.
2. In the Oracle Apps Adapter menu in the navigation area, click Transaction Mgmt.
3. Click Transaction Configuration.
4. From the Oracle Apps Release list, select the Oracle Applications release for the transaction
you want to delete.
5. Select the appropriate Transaction Type.
6. Click on the transaction you want to delete.
7. Click Delete.

Working with SQL Trees in Oracle Applications -to-Integration
Server Transactions
Oracle Apps Adapter uses SQL trees to build and run Oracle Applications -to-Integration Server
transaction definitions. SQL trees are hierarchical SQL statements that the adapter executes at run
time to retrieve data from an Oracle Applications system and to store the data in a hierarchical
format that is easily accessible in integration flows.
SQL trees enable the adapter to collect data from separate tables and to place (join) the results in
a hierarchical structure rather than in a standard result set. You must understand how Oracle
Apps Adapter uses SQL trees to define Oracle Applications -to-Integration Server transaction
definitions before you create or edit the transaction definitions.
SQL trees are made up of a series of SQL query calls called aliases. You can specify an alias's SQL
query either as a SQL SELECT statement or as a stored procedure. Each SQL tree contains one
top-level SQL statement and one or more child SQL statements. Child level SQL statements retrieve
data from Oracle Applications using results from the top-level SQL statement as the query input
parameters in their own SQL calls.

SQL SELECT Statement Syntax
When you specify a SQL SELECT statement for the top-level alias in the SQL tree, the SQL statement
should include any WHERE statements or ORDER BY statements the SQL statement will use to
issue the query. You will use the results of the top-level alias query as input parameters when you
define the top-level's child aliases for the SQL tree.
Within the top-level alias's SQL statement you can define input variables that will be defined as
service inputs when you configure a service using the transaction definition. To define a SQL
statement's input as a variable, place the parameter between an ampersand (&) and an asterisk
(*). You cannot define service input variables for non-top-level aliases.
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When you specify a SQL statement for a child alias, define the SQL statement without defining
the query's WHERE clause. You will define the input and join parameters for the child alias's SQL
statement as the alias's relations. An alias's relations populate the child alias's input and join
parameters using output values from alias's parent alias. You can also specify constant values as
input parameters in a relation.
When you specify the query using a SQL SELECT statement, specify the alias's relations as name
value pairs. Be sure to leave a space before and after the equals sign (=) in the name value pairs.
For example:
COLUMN = PARENT_ALIAS.COLUMN AND COLUMN2 = PARENT_ALIAS.COLUMN2 ...

The results of a child alias' SQL query statement will be stored as a child section of the results
record. The resulting child record will be named the alias name. The output names in the child
record will be based on the column names returned from the alias's SELECT statement.

Stored Procedure Syntax
To specify a stored procedure in an alias, enter the stored procedure as follows:
schema.package.procname

If the stored procedure is not in a package, you do not have to specify the schema and the package.
To specify the relations for a child alias that issues a stored procedure, you can enter the stored
procedure inputs as the parent alias's output values (if applicable), or you can enter the stored
procedure inputs as constant values. Specify the inputs, separated by commas, in the order that
the stored procedure requires them. You can also specify constant values as input parameters in
a relation. Type parent columns in uppercase.
For example, specify the alias's relations as follows:
PARENT_ALIAS.COLUMN1, PARENT_ALIAS.COLUMN2 ...

The results of the stored procedure will be stored in the parent alias' result record. The outputs
will be given the names of the stored procedures output parameters.
Note:
You cannot add a child alias to an alias that issues a stored procedure.

SQL Tree Example
This section illustrates how to use SQL trees to retrieve data from an Oracle Applications system
and to store it in a hierarchical format that is easy to access within flows.
Suppose you want a service to execute a transaction that retrieves customer names and phone
numbers using a customer ID input parameter. For this example, the database contains the following
tables and data.
TABLE1 looks like this:
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ID

STATUS

NAME

001

N

John Smith

TABLE2 looks like this:
ID

PHONE

001

(888) 555-1212

TABLE3 looks like this:
ID

STREET

001

Main Street

001

Broadway Blvd.

Also, suppose you want the output from the transaction to be a results document in the following
format:

Based on the customer's status, you want to use the customer's ID to retrieve the rest of the
customer's information. To retrieve the customer's phone number, you want to use an existing
stored procedure: GetCustomerPhone.
To define the transaction definition you will create a parent alias and two child aliases in the SQL
tree, as follows:

Parent Level Alias
This alias retrieves the customer's ID and name based on the customer's status. You will use the
ID field from this alias to query the database in the two child aliases.
Field

Value

Alias Name

CUSTOMERS

SQL

SELECT NAME, ID FROM TABLE1 WHERE STATUS = ‘N' ORDER BY
NAME
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Child Alias 1
This child alias issues a stored procedure to gather phone number information for each customer.
The stored procedure's input value is ID, and its output value is PHONE.
Field

Value

Alias Name

PHONENUMBER

SQL

APPS.YYY.GETCUSTOMERPHONE

Relation

CUSTOMER.ID

Child Alias 2
This child alias issues a SQL SELECT statement to retrieve address information for each customer
that was returned in the parent alias's query. This alias can return more than one address, each of
which will appear as documents within an ADDRESS document list in the results document.
Field

Value

Alias Name

ADDRESS

SQL

SELECT STREET FROM TABLE3

Relation

ID = CUSTOMER.ID

Note that the relation field refers to the ID field in the parent alias name, not to the database table
name. At run time the service will issue a SELECT statement as follows:
SELECT STREET FROM TABLE3 WHERE ID = valueFromParent

Results
Using the values supplied in the sample tables, the outcome of this transaction would look like
this:
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Overview
This chapter describes how to configure and manage Oracle Apps Adapter services. For detailed
descriptions of the available Oracle Apps Adapter services, see “Adapter Services” on page 18.

Before Configuring or Managing Adapter Services
To prepare to configure or manage Oracle Apps Adapter services
1. Start Integration Server and Integration Server Administrator, if they are not already running.
2. Make sure that you have Integration Server administrator privileges so that you can access
Oracle Apps Adapter administrative screens. For information about setting user privileges,
see the webMethods Integration Server Administrator’s Guide for your release.
3. Using Integration Server Administrator, make sure the WmOAAdapter package is enabled.
See “Enabling Packages” on page 29 for instructions.
4. Using Integration Server Administrator, configure an adapter connection to use with the
adapter service. See “Configuring Adapter Connections” on page 41 for instructions.
5. Start Designer if it is not already running.
Note:
If you are using Designer, use the Service Development perspective. For more information,
see the webMethods Service Development Help for your release.
6. Make sure that you enable the Automatic data validation. For detailed instructions on how to
enable automatic data validation, see “Enabling Automatic Data Validation” on page 72.
7. Using Designer, create a user-defined package to contain the service, if you have not already
done so. When you configure adapter services, you should always define them in user-defined
packages rather than in the WmOAAdapter package. For more information about managing
packages for the adapter, see “ Oracle Apps Adapter Package Management” on page 28.
Important:
If the transaction definitions do not accurately reflect the Oracle Applications use of the DBMS,
unpredictable results can occur when the service is run. The webMethods administrator should
review the transaction definition with an Oracle Applications administrator to make sure they
are suitable for each Oracle Apps Adapter service. For information about updating the transaction
definitions, see “Editing Integration Server-to- Oracle Applications Transaction Definitions” on
page 56 and “Editing Oracle Applications -to-Integration Server Transaction Definitions” on
page 57.
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Using Oracle Apps Adapter Services
The following table lists the tasks required to use adapter services:
Task

Use this tool...

1

Configure an adapter connection. See “Configuring
Adapter Connections” on page 41 for details.

Integration Server Administrator
(Adapters menu)

2

Import the transaction definitions or configure new
Integration Server Administrator
transaction definitions to be used by the service. For
(Adapters menu)
instructions, see “Importing Transaction Definitions” on
page 50.

3

Select the appropriate adapter service template and
configure the adapter service. Refer to the appropriate
service section in this chapter for more information on
configuring the specific adapter services.

4

If you plan to use an Integration Server flow or Java
Designer
service to invoke the adapter service, use Designer to
design the flow or Java service to use this adapter service.
For details, see the webMethods Service Development Help
for your release.

5

Manage the adapter service. See “Package
Designer, and Integration Server
Management” on page 27 and “Logging and Exception Administrator
Handling” on page 85 for details.

Designer

Configuring Insert SQL Services
Insert services enable the adapter to insert records into the Oracle Applications open interface
tables. These records will either insert new information or update existing information in the
Oracle Applications system.
For more information about Insert SQL services, see “Adapter Service Templates” on page 19.
To configure an Insert SQL service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. Perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
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b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select Oracle Apps Adapter as the adapter type and click Next.
5. Select the appropriate Adapter Connection Name and click Next.
6. From the list of available templates, select the Insert SQL and do the following:
Select a package and folder to contain the service, type a unique name for the service.
Select a package that contains only services that execute Oracle Applications transactions. By
doing this, it is easier to back up and replicate those services because they are all contained in
a separate package.
Important:
Do not store the services in the Oracle Applications package ( WmOAAdapter ) because the
package is replaced when you upgrade the Oracle Apps Adapter.
7. Click Finish.
Once you create the service in Designer, the adapter service editor for the Insert SQL service
appears.
8. Select the Insert SQL tab, if it is not already selected.
9. Select a transaction definition from the Transaction list.
10. You can select the Adapter Settings tab at any time to confirm adapter service properties such
as the Adapter Name, Adapter Connection Name, and Adapter Service Template, as
necessary.
For information about configuring the Input/Output tab, see the webMethods Service Development
Help for your release. This tab applies to all services that you configure using Designer.
11. From the File menu, select Save.
To test the service directly from Designer, see “Testing Adapter Services” on page 70.
You might also want to configure an Error service to verify that the information was correctly
inserted. For more information, see “Configuring Simple SQL Services” on page 68.

Configuring Compound Select SQL Services
Includes Select services. For more information about Compound Select SQL services, see “Adapter
Service Templates” on page 19.
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To configure a Compound Select SQL service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. If you are using Designer, perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select Adapter Service from the list of elements, and click Next.
5. Select Oracle Apps Adapter as the adapter type, and click Next.
6. Select the appropriate Adapter Connection Name, and click Next.
7. Select the Compound Select SQL template and do the following:
Select a package and folder to contain the service, type a unique name for the service.
Select a package that contains only services that execute Oracle Applications transactions. By
doing this, it is easier to back up and replicate those services because they are all contained in
a separate package.
Important:
Do not store the services in the Oracle Applications package ( WmOAAdapter ) because the
package is replaced when you upgrade the Oracle Apps Adapter.
8. Click Finish.
9. Select the Compound Select SQL tab, if it is not already selected.
10. Select a transaction definition from the Transaction list.
11. You can select the Adapter Settings tab at any time to confirm adapter service properties such
as the Adapter Name, Adapter Connection Name, and Adapter Service Template, as
necessary.
12. For information about configuring the Input/Output tab, see the webMethods Service Development
Help for your release. This tab applies to all services that you configure using Designer.
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13. From the File menu, select Save.
To test the service directly from Designer, see “Testing Adapter Services” on page 70.

Configuring Simple SQL Services
Use Simple SQL services to create Acknowledge and Error services.
For more information about Simple SQL services, see “Adapter Service Templates” on page 19.

Acknowledge Services
To configure an Acknowledge service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. If you are using Designer, perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select Oracle Apps Adapter as the adapter type, and then click Next.
5. Select the appropriate Adapter Connection Name, and then click Next.
6. Select the Simple SQL template and do the following:
Select a package and folder to contain the service, type a unique name for the service.
Select a package that contains only services that execute Oracle Applications transactions. By
doing this, it is easier to back up and replicate those services because they are all contained in
a separate package.
Important:
Do not store the services in the Oracle Applications package ( WmOAAdapter ) because the
package is replaced when you upgrade the Oracle Apps Adapter.
7. Click Finish.
8. Select the Simple SQL tab, if it is not already selected.
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9. Select AcknowledgeSQL from the Simple SQL Type list.
10. Select a transaction definition from the Transaction list.
Note:
When calling a stored procedure, ignore the output.
11. You can select the Adapter Settings tab at any time to confirm adapter service properties such
as the Adapter Name, Adapter Connection Name, and Adapter Service Template, as
necessary.
12. For information about configuring the Input/Output tab, see the webMethods Service Development
Help for your release. This tab applies to all services that you configure using Designer.
13. From the File menu, select Save.

Error Services
To configure an Error service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. If you are using Designer, perform the following:
a. Right-click the package in which the service should be contained and select New > Adapter
Service.
b. Select the parent namespace and type a name for the adapter service.
c. Click Next.
4. Select Adapter Service from the list of elements, and click Next.
5. Select Oracle Apps Adapter as the adapter type, and click Next.
6. Select the appropriate Adapter Connection Name, and click Next.
7. Select the Simple SQL template and do the following:
Select a package and folder to contain the service, type a unique name for the service.
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Select a package that contains only services that execute Oracle Applications transactions. By
doing this, it is easier to back up and replicate those services because they are all contained in
a separate package.
Important:
Do not store the services in the Oracle Applications package ( WmOAAdapter ) because the
package is replaced when you upgrade the Oracle Apps Adapter.
8. Click Finish.
9. Select the Simple SQL tab, if it is not already selected.
10. Select ErrorSQL from the Simple SQL Type list.
11. Select a transaction definition from the Transaction list.
12. You can select the Adapter Settings tab at any time to confirm adapter service properties such
as the Adapter Name, Adapter Connection Name, and Adapter Service Template, as
necessary.
13. For information about configuring the Input/Output tab, see the webMethods Service Development
Help for your release. This tab applies to all services that you configure using Designer.
14. From the File menu, select Save.

Testing Adapter Services
You can use Designer to test adapter services.
For more information about testing and debugging services, see the webMethods Service Development
Help for your release.
To test a service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. In Designer, expand the package and folder that contain the service you want to test.
3. Double-click the service you want to test.
Designer displays the configured service in the service template's Adapter Service Editor.
4. Using Designer, select Run > Run As > Run Service.
5. For every service input field, you will be prompted to enter an input value. Enter a value for
each input field and then click OK.
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6. Click the Service Result tab (in Designer) to view the output from this service.

Viewing Adapter Services
You use Designer to view adapter services.
To view a service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. In Integration Server, enable the connection for the service you want to edit. For instructions
on enabling connections, see “Enabling Adapter Connections” on page 45.
3. In Designer, expand the package and folder that contain the service you want to view.
4. Double-click the service you want to view.
Designer displays the configured service in the service template's Adapter Service Editor.

Editing Adapter Services
You use Designer to edit adapter services.
To edit an adapter service
1. In Designer, browse to and open the adapter service that you want to edit.
2. Double-click the service that you want to edit.
Designer displays the adapter service in the service template's Adapter Service Editor.
3. Do one of the following:
If you have the VCS Integration feature enabled, right-click the service and select Check
Out.
If you do not have the VCS Integration feature enabled, right-click the service and select
Lock for Edit.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the service. The options available in the Team
menu depend on the VCS client that you use.
4. Modify the values for the adapter service's parameters as needed. For detailed descriptions of
the service's parameters, see the section on configuring a service for the specific type of service
you want to edit.
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5. After you complete your modifications, save the service and do one of the following:
If you have the VCS Integration feature enabled, right-click the service and select Check
In. Enter a check-in comment and click OK.
If you do not have the VCS Integration feature enabled, right-click the service and select
Unlock.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the service. The options available in the Team
menu depend on the VCS client that you use.
6. Save the service.

Deleting Adapter Services
You use Designer to delete adapter services.
To delete a service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. In Designer, expand the package and folder that contain the service you want to delete.
3. Right-click the service you want to delete and then select Delete.

Enabling Automatic Data Validation
Designer enables the Oracle Apps Adapter to validate user-defined data for adapter services at
design time. You can validate the values for a single adapter service or you can configure Designer
to always validate the values for adapter services. Both options could potentially slow your
design-time operations.
When you enable data validation for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.
If you select the option to always validate values for adapter services, it will do so for all
webMethods 6.x adapters installed on Integration Server.
For more information about the Adapter Service/Notification Editorand other Designer menu
options and toolbar icons, see the webMethods Service Development Help for your release.

For a Single Adapter Service
To enable automatic data validation for a single adapter service
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
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2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
3. Double-click the service for which you want to validate the data.
Designer displays the configured adapter service in the service template's Adapter Service
Editor.
4. Click the

icon.

For All Adapter Services
To enable automatic data validation for all values in adapter services
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. f you are using Designer, select Window > Preferences > Software AG > Service
Development > Adapter Service/Notification Editor.
4. Enable the Automatic data validation option.
5. Click OK.

Reloading Adapter Values
Designer enables Oracle Apps Adapter to reload and validate user-defined data for adapter services
at design time. You can reload values for a single adapter service or you can configure Designer
to automatically reload the values for all adapter services. Both options could potentially slow
your design-time operations.
When you reload adapter values for a single adapter service, Designer compares the service values
against the resource data that has already been fetched from the selected adapter.
If you select the option to always reload values for adapter services, it will do so for all webMethods
6.x adapters installed on Integration Server.
For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

For a Single Adapter Service
To reload the adapter values for a single adapter service
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1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
3. Double-click the service for which you want to validate the data.
Designer displays the configured adapter service in the service template's Adapter Service
Editor.
4. Click the

icon.

For All Adapter Services
To reload the adapter values for all adapter services
1. Review the steps in “Before Configuring or Managing Adapter Services” on page 64.
2. Start Designer.
3. If you are using Designer, click Window > Preferences > Software AG > Service
Development > Adapter Service/Notification Editor.
4. Enable the Automatic polling of adapter metadata option.
5. Click OK.
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Overview
This chapter describes how to configure and manage Oracle Apps Adapter notifications. For
detailed descriptions of the available Oracle Apps Adapter notifications, see “Adapter
Notifications” on page 20.

Before Configuring or Managing Notifications
To prepare to configure or manage Oracle Apps Adapter notifications
1. Start Integration Server and Integration Server Administrator, if they are not already running.
2. Make sure that you have Integration Server administrator and developer privileges so that
you can access Oracle Apps Adapter administrative and Designer screens. For information
about setting user privileges, see the webMethods Integration Server Administrator’s Guide for
your release.
3. Using Integration Server Administrator, make sure the WmOAAdapter package is enabled.
See “Enabling and Disabling Packages” on page 29 for instructions.
4. Using Integration Server Administrator, configure an adapter connection to use with the
notification. See “Configuring Adapter Connections” on page 41 for instructions.
Note:Integration Server solves this limitation by providing a built-in service that you can
use at design time to change the connection associated with a polling notification. For more
information, see “Changing the Connection Associated with an Adapter Service or Polling
Notification at Design Time” on page 17.
5. Start Designer if it is not already running.
Note:
If you are using Designer, use the Service Development perspective. For more information,
see the webMethods Service Development Help for your release.
6. Using Designer, create a user-defined package to contain the notification, if you have not
already done so. When you configure notifications, define them always in user-defined packages
rather than in the WmOAAdapter package. For more information about managing packages
for the adapter, see “Package Management” on page 27.
7. You must schedule a notification and then enable it before you can use the notification. See
“Managing Polling Notifications” on page 78 for instructions.

Configuring Notifications
Be sure to review the section “Before Configuring or Managing Notifications” on page 76 before
you configure notifications.
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To configure a notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. Start Designer.
3. If you are using Designer, perform the following:
a. Right-click the package in which the notification should be contained and select New >
Adapter Notification.
b. Select the parent namespace and type a name for the adapter notification.
c. Click Next.
Important:
Do not store the notifications in the Oracle Applications package ( WmOAAdapter )
because the package is replaced when you upgrade the Oracle Apps Adapter.
4. Select Oracle Apps Adapter as the adapter type and click Next.
5. Select Polling Notification as the template and click Next.
6. Select the appropriate Adapter Connection Name and click Next.
7. Select a package and folder to contain the notification, type a unique name for the notification,
and click Next.
Select a package that contains only notifications that execute Oracle Applications transactions.
By doing this, it is easier to back up and replicate those notifications because they are all
contained in a separate package.
Important:
Do not store the notifications in the Oracle Applications package ( WmOAAdapter ) because
the package is replaced when you upgrade the Oracle Apps Adapter.
8. The name of the publishable document associated with this notification displays. Click Finish.
For more information about adapter notifications and publishable documents, see “Adapter
Notifications” on page 20. For more details about Integration Server publishable documents,
see the Publish-Subscribe Developer’s Guide for your release.
9. Designer creates the notification, and the editor for the adapter notification appears.
a. You can select the Adapter Settings tab at any time to confirm adapter notification
properties such as the Adapter Name, Adapter Connection Name, and Adapter
Notification Template, as necessary.
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b. In the Publish Document section, you can also specify how you want the notification
document to be published:
To publish documents to Broker, select webMethods Broker/Local. This is the default
option.
To publish documents to a JMS provider, select JMS Provider, and provide values for
the following input fields:
Field

Description/Action

Connection alias The name of the JMS connection alias configured on Integration
Server.
name
Destination name The name of the destination from which you want the JMS trigger to
receive messages.
Destination type

Whether the destination is a Queue (default) or a Topic.

The information from the Permissions tab appears in the Properties panel.
10. Select the Polling Notification tab, if it is not already selected.
11. Select a transaction definition from the Transaction list. The editor completes the remaining
fields based on the transaction selected.
12. From the File menu, select Save.
13. You must create a trigger for the publishable document associated with the notification. For
more information about creating triggers and working with publishable documents, see the
Publish-Subscribe Developer’s Guide for your release.
14. By default a notification is disabled when it is configured. You must schedule and enable the
notification using Integration Server Administrator before you can use it. See “Managing
Polling Notifications” on page 78 for details.

Managing Polling Notifications
Using Integration Server Administrator you can display all polling notifications that have been
configured for Oracle Apps Adapter. You can also enable and disable a notification and schedule
it for execution.
You must schedule a notification and then enable it before you can use the notification.
Note:
You must have Integration Server administrator privileges to access Oracle Apps Adapter's
administrative screens. For information about setting user privileges, see the webMethods
Integration Server Administrator’s Guide for your release.
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To manage polling notifications
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. Start Integration Server Administrator.
3. From the Adapters menu in the navigation area of Integration Server Administrator, select
Oracle Apps Adapter.
4. From the navigation area, select Polling Notifications. All configured Oracle Apps Adapter
notifications are displayed.
5. From the Oracle Apps Adapter Polling Notificationstable, use the fields in the following
table to manage each adapter notification:
Field

Description/Action

Notification Name

The name of the notification.

Package Name

The name of the package for the notification.

State

Note:
You must schedule a polling notification before you can enable it.
To schedule a polling notification, use the icon describe d in these
procedures.
After you schedule a polling notification, you can use this option's
drop-down list to set the polling notification's state:
Enabled: The polling notification performs as scheduled.
Suspended: The polling notification is removed from the
scheduler but the database trigger and buffer table are not
dropped.
Disabled: The polling notification is removed from the scheduler
and the database trigger and buffer table are dropped.
The Suspend all enabled and Resume all suspended links help
you change states quickly for multiple polling notifications.
If there is no polling notification scheduled for a given adapter
notification, control for this field is disabled. Use the Edit Schedule
icon to create a polling notification as described in step 6.

Edit Schedule

Click the icon to create or modify polling notification parameters.
Use the instructions in step 6 to create or modify a notification's
schedule parameters.
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Field

Description/Action
Note:
You must disable a polling notification before you can edit it.

View Schedule

Click the icon to review the parameters for the selected polling
notification. If the notification has not been scheduled, the icon is
greyed out.
Click Return to Oracle Apps Adapter Notificationsto go back to the
main polling notification page.

6. To create or modify schedule parameters for the selected adapter notification:
a. Click the

icon and specify the following schedule parameters:

Field

Description/Action

Interval (seconds) Enter the polling interval time in seconds.
By default the next polling interval starts after the current execution
is completed.
Overlap

Note:
Do not use this option; otherwise, when you enable this notification,
it might lock up tables and cause Integration Server to fail.

Immediate

Enable this option to start polling immediately.
By default the polling interval begins when the notification is enabled
but enabling this option causes the notification to start immediately
after it is enabled.

b. When you are finished, click Save Schedule.
7. After you configure or modify a polling notification, you can enable it. Use the State or Enabled
field described in step 5 to enable a polling notification.

Exporting Configured Adapter Notifications
You can export notifications from one Integration Server to another Integration Server. You do
not need to disable notifications in order to export them. In most cases, the current state of the
notifications in the package that you export is retained. However, if you deploy to a different
Integration Server and connect to a different database, then you should first disable the notification.
Note:
A given notification can only run on one Integration Server at a time.
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For more information about exporting packages, see the webMethods Integration Server Administrator’s
Guide for your release.

Viewing Notifications
You use Designer to view notifications.
To view a notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. In Integration Server Administrator, enable the connection for the notification you want to
edit. For instructions on enabling connections, see “Enabling Adapter Connections” on page 45.
3. In Designer, expand the package and folder that contain the notification you want to view.
4. Select the notification you want to view.
Designer displays the notification in the notification template's Adapter Notification Editor.

Editing Notifications
You use Designer to edit notifications.
You can change the connection associated with an adapter notification with the built-in service
pub.art.notification:setPollingNotificationNodeConnection. For more information, see “Changing the Connection
Associated with an Adapter Service or Polling Notification at Design Time” on page 17.
To edit a notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. In Integration Server Administrator, enable the connection for the notification you want to
edit. For instructions on enabling connections, see “Enabling Adapter Connections” on page 45.
3. In Designer, expand the package and folder that contain the notification you want to view.
4. Select the notification you want to edit.
Designer displays the notification in the notification template's Adapter Notification Editor.
5. Do one of the following:
If you have the VCS Integration feature enabled, right-click the notification and select
Check Out.
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If you do not have the VCS Integration feature enabled, right-click the notification and
select Lock for Edit.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check out the notification. The options available in the
Team menu depend on the VCS client that you use.
6. Modify the values for the notification's parameters as needed. For detailed descriptions of the
notification's parameters, see the section on configuring a notification for the specific type of
notification you want to edit.
7. After you complete your modifications, save the notification and do one of the following:
If you have the VCS Integration feature enabled, right-click the notification and select
Check In. Enter a check-in comment and click OK.
If you do not have the VCS Integration feature enabled, right-click the notification and
select Unlock.
If you are using the local service development feature, from the Team menu in Designer,
select the appropriate option to check in the notification. The options available in the Team
menu depend on the VCS client that you use.

Deleting Notifications
You use Designer to delete adapter notifications.
Note:
Deleting a notification also deletes the associated publishable document.
To delete a notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. In Integration Server Administrator, disable the notification. Otherwise, the trigger and buffer
table created by the notification will remain in the database. To disable a notification, see
“Managing Polling Notifications” on page 78.
3. In Designer, expand the package and folder that contain the notification you want to delete.
4. Right-click the notification and then click Delete.

Validating Adapter Notification Values
Designer enable the Oracle Apps Adapter to validate user-defined data for adapter notifications
at design time. You can validate the values for a single notification or you can configure Designer
to always validate the values for notifications. Both options could potentially slow your design-time
operations.
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When you enable data validation for a single adapter notification, Designer compares the
notification values against the resource data that has already been fetched from the selected adapter.
If you select the option to always validate values for adapter notifications, it will do so for all
webMethods 6.x adapters installed on Integration Server.
For more information about the Adapter Service/Notification Editor, other Designer menu
options, and toolbar icons, see the webMethods Service Development Help for your release.

For a Single Adapter Notification
To enable automatic data validation a single adapter notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. In Designer, expand the package and folder that contain the notification for which you want
to enable automatic validation.
3. Double-click the notification for which you want to validate the data.
Designer displays the configured adapter notification in the service template's Adapter
Notification Editor.
4. Click the

icon.

For All Values in Adapter Notifications
To enable automatic data validation for all values in adapter notifications
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. Start Designer.
3. If you are using Designer, select the Window > Preferences > Software AG > Service
Development > Adapter Service/Notification Editoritem.
4. Enable the Automatic data validation option.
5. Click OK.

Reloading Adapter Values
Designer enable Oracle Apps Adapter to reload and validate user-defined data for notifications
at design time. You can reload values for a single notification or you can configure Designer to
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automatically reload the values for adapter notifications. Both options could potentially slow your
design-time operations.
When you reload adapter values for a single adapter notification, Designer compares the notification
values against the resource data that has already been fetched from the selected adapter.
If you select the option to always reload values for adapter notifications, it will do so for all
webMethods 6.x adapters installed on Integration Server.
For more information about the Adapter Service/Notification Editor, other menu options, and
toolbar icons, see the webMethods Service Development Help for your release.

For a Single Adapter Notification
To reload the adapter values for a single adapter notification
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. In Designer, expand the package and folder that contain the service for which you want to
enable automatic validation.
3. Double-click the service for which you want to validate the data.
Designer displays the configured adapter service in the service template's Adapter Notification
Editor.
4. Click the

icon.

For All Adapter Notifications Automatically
To automatically reload the values for adapter notifications
1. Review the steps in “Before Configuring or Managing Notifications” on page 76.
2. Start Designer.
3. If you are using Designer, select the Window > Preferences > Software AG > Service
Development > Adapter Service/Notification Editoritem.
4. Enable the Automatic polling of adapter metadata option.
5. Click OK.
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Overview
The following sections describe message logging and exception handling for Oracle Apps Adapter.
A list of error codes and supporting information appears in “ Oracle Apps Adapter Error Codes” on
page 88.

Adapter Logging Levels
Oracle Apps Adapter uses the Integration Server logging mechanism to log messages. You can
configure and view Integration Server logs to monitor and troubleshoot Oracle Apps Adapter.
For detailed information and viewing the different kinds of logs supported by the server, see the
webMethods Integration Server Administrator’s Guide for your release.

Configuring Adapter Logging Levels
You can use Integration Server to configure different logging levels for Oracle Apps Adapter.
To access the adapter's logging information and change logging settings
1. From Integration Server Administrator, select Settings > Logging.
On the Logging Settings screen appears, the Loggers section has Adapters included in the
Facility section.
2. Expand theAdapters tree to see a list of all installed adapters with their code number and
adapter description, along with the logging level.
3. Select Edit Logging Settings.
4. Select the required Level of logging for Oracle Apps Adapter.
5. After making your changes, click Save Changes.
6. For complete information about specifying the amount and type of information to include in
the log, see the webMethods Audit Logging Guide for your release.

Oracle Apps Adapter Message Logging
Integration Server maintains several types of logs; however, Oracle Apps Adapter only logs
messages to the Audit, Error and Server logs, as described in the table below:
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Integration Server Log
Version

Description

7.1.2 or higher

Audit Log

You can monitor individual adapter services using the audit
log as you would audit any service in Integration Server.
The audit properties for an adapter service are available in
the Oracle Apps Adapter service template in the Properties
panel.

Error Log

Oracle Apps Adapter automatically posts fatal-level and
error-level log messages to the error log. These log messages
will appear as Adapter Runtime messages.

Server Log

Oracle Apps Adapter posts messages to the server log,
depending on how the server log is configured. Fatal-level
through debug-level log messages appear as Adapter
Runtime log messages. Trace-level log messages appear as
Oracle Apps Adapter log messages.

Audit Log

You can monitor individual adapter services using the audit
log as you would audit any service in Integration Server.
The audit properties for an adapter service are available in
each Oracle Apps Adapter service template in the Properties
panel.

Error Log

Oracle Apps Adapter automatically posts critical-level and
error-level log messages to Integration Server's Error log.
These log messages will appear as Adapter Runtime
messages.

Server Log

Oracle Apps Adapter posts messages to the Integration
Server log, depending on how the server log is configured.
Critical-level through debug-level log messages appear as
Adapter Runtime log messages. V1-Verbose1 or V4-Verbose4
log messages appear as Oracle Apps Adapter log messages.

6.5

Oracle Apps Adapter's log messages appear in the following format: ADA.0336.nnnnc, where:
ADA is the facility code that indicates that the message is from an adapter.
0336 (or 336) is the Oracle Apps Adapter major code, which indicates that the error is generated
by Oracle Apps Adapter.
nnnn represents the error's minor code. For detailed descriptions of Oracle Apps Adapter's
minor codes, see “ Oracle Apps Adapter Error Codes” on page 88.
c represents the message's severity level (optional).
Because Oracle Apps Adapter works in conjunction with the WmART package, the adapter's
messages and exceptions typically appear within log messages for the WmART package, although
that is not necessarily true for verbose-level messages.
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To monitor Oracle Apps Adapter's log messages in the Server log, ensure that your server log's
logging settings are configured to monitor the following facilities:
0113 Adapter Runtime (Managed Object)
0114 Adapter Runtime
0115 Adapter Runtime (Listener)
0116 Adapter Runtime (Notification)
0117 Adapter Runtime (Adapter Service)
0118 Adapter Runtime (Connection)
0121 Adapter Runtime (SCC Transaction Manager)
0126 Adapter Runtime (SCC Connection Manager)

Oracle Applications Error Handling
If an Oracle Apps Adapter object (for example, a connection or service) encounters an error with
the Oracle Applications system, the object will throw an adapter error coupled with the Oracle
Applications error, exactly as it was thrown by Oracle Applications . The Oracle Applications
errors will be in the IData format.
For example, if an adapter service fails on the Oracle Applications system at run time because its
input fields contain invalid values, you will receive an adapter error that indicates that the service
failed, and the adapter error will contain the specific error generated on the Oracle Applications
system indicating why the service failed. In this case, you would receive an Oracle Applications
error specifying that the input values are invalid.

Oracle Apps Adapter Error Codes
This section lists Oracle Apps Adapter's Critical- and Error-level minor codes, including the text
of each error, information about the cause of the errors, and possible responses to the errors.
Error Code

Description

0

Missing required input: value.
Explanation: The specified required input is missing.
Action: Provide the required input and then retry the operation.

3

OARelease is an unsupported Oracle Applications release.
Explanation: The adapter does not support your version of Oracle Applications .
Action: See the webMethods Adapters System Requirements for the supported versions
of Oracle Applications .
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Error Code

Description

4

Unable to connect to the repository to perform the operation. Error logged.
Explanation: While importing or exporting transaction definition files, the adapter
is not able to connect to the repository or shared cache.
Action: Check the remote repository or shared cache and ensure that it is running.
Check the network and ensure that there are no network problems.

5

Unable to obtain a lock on the repository to perform the operation. Error logged.
Explanation: While importing or exporting transaction definition files, the adapter
is not able to lock the repository or shared cache to update the transaction definition.
This error might be caused when multiple users are importing or exporting large
transaction definition files at the same time.
Action: Determine whether another user is performing the same operation.

6

Error accessing the repository. Error logged.
Explanation: The adapter is not able to operate on the remote repository or shared
cache.
Action: Check remote repository or shared cache and ensure that it is running.
Check the network and ensure that there are no network problems.

7

transactionDefinitionFile already exists.
Explanation: The indicated transaction definition file (.txp) already exists.
Action: Check the file names and change names that are the same.

8

transactionName does not exist.
Explanation: The indicated required configuration information is not available.
This error might be caused by an incorrectly configured service or notification.
Action: Check the service or notification configuration and verify that the
information is correct.

9

Unable to retrieve version - error logged.
Explanation: The adapter cannot retrieve the WmOAAdapter version number.
Action: Replace the corrupted manifest file.

10

Unable to retrieve build - error logged.
Explanation: The adapter cannot retrieve the WmOAAdapter build number.
Action: Replace the corrupted manifest file.

100

Error rolling back tran: transaction.
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Error Code

Description
Explanation: The adapter encountered an error while trying to roll back the
indicated transaction. This error might be caused by the adapter connection being
lost.
Action: Check the database log to see the error information, and then address the
error as necessary.

101

No connection found.
Explanation: An invalid connection was specified or the connection is no longer
available.
Action: Specify a valid connection.

102

Number of data values does not match the number of variables.
Explanation: The number of data values supplied to the service does not match
the required number of variables.
Ensure that the number of data values matches the number of variables.

103

Method only valid on raw SQL commands.
Explanation: The Oracle Applications -to-Integration Server transaction definition
incorrectly uses SQL statements and stored procedures.
Action: You cannot combine stored procedures with SQL queries in an Oracle
Applications -to-Integration Server transaction definition. Use only stored
procedures or SQL trees. See “Creating Oracle Applications -to-Integration Server
Transaction Definitions” on page 55 for more information.

104

Method only valid on Stored Procedure commands.
Explanation: The Oracle Applications -to-Integration Server transaction definition
incorrectly uses SQL statements and stored procedures.
Action: You cannot combine stored procedures with SQL queries in an Oracle
Applications -to-Integration Server transaction definition. Use only stored
procedures or SQL trees. See “Creating Oracle Applications -to-Integration Server
Transaction Definitions” on page 55 for more information.

110

Exception caught: exceptionMessage.
Explanation: A Java Exception has been caught.
Action: Determine the cause of the exception and correct the problem. If necessary,
provide this information to a Software AG Global Support representative.

111

SQL Exception caught: exceptionMessage.
Explanation: A SQL statement execution exception has been caught.
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Error Code

Description
Action: Determine the cause of the exception and correct the problem. Refer to the
Oracle database manual for any error code specified in the exceptionMessage. If
necessary, provide this information to a Software AG Global Support representative.

112

An inbound SQL statement must start with INSERT, UPDATE, DELETE or be
a stored procedure call.
Explanation: An Integration Server-to- Oracle Applications transaction definition
contains an invalid SQL statement. The invalid SQL statement does not start with
INSERT, UPDATE, DELETE, or a stored procedure call.
Action: Correct the statement in the transaction definition by starting it with
INSERT, UPDATE, DELETE, or a stored procedure call.

113

An outbound SQL statement must start with SELECT or be a stored procedure
call.
Explanation: An Oracle Applications -to-Integration Server transaction definition
contains an invalid SQL statement. The invalid SQL statement does not start with
SELECT or is not a stored procedure call.
Action: Examine the transaction definition, and correct the SQL statement or use
a stored procedure call.

114

Ill-formed stored procedure call storedProcedure.
Explanation: The statement to refer to the Stored Procedure is syntactically invalid.
Action: Correct the statement in the transaction definition.

118

variableText missing from transaction definition.
Explanation: The indicated information is missing from the transaction definition.
Action: Add the missing information to the transaction definition.

214

Error executing SQL for alias nodeName, SQLerrorMessage.
Explanation: Configure time error. The adapter is not able to execute the SQL
statement defined under an alias node of the SQL tree of an Oracle Applications
-to-Integration Server transaction definition.
Action: Correct the transaction definition.

300

Error saving export file: filename - error logged.
Explanation: The adapter cannot create the export file correctly.
Action: Possibly a file system access privilege issue, or not enough disk space.

301

File name importTransactionDefFile contains invalid characters.
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Error Code

Description
Explanation: The file contains invalid characters.
Action: The characters are invalid for Oracle or invalid for the adapter.

302

Invalid file contents. Missing tagName tag.
Explanation: While importing a transaction definition transport file (.txp), the
adapter detected invalid contents in the file.
Action: Correct the transaction definition transport file and reimport it, or remove
the file from the Integration Server_directory \packages\ WmOAAdapter \exchange
directory.

303

Invalid file contents. Missing valueName value.
Explanation: While importing a transaction definition transport file (.txp), the
adapter detected invalid contents in the file.
Action: Correct the transaction definition transport file and reimport it, or remove
the file from the Integration Server_directory \packages\ WmOAAdapter \exchange
directory.

304

Unsupported Oracle Applications Release version found in file.
Explanation: While importing a transaction definition transport file (.txp), the
adapter found a version of Oracle Applications that it does not support.
Action: Examine the transaction definition file and specify a supported version of
Oracle Applications . See the webMethods Adapters System Requirements for the
supported versions.

305

fileName file not found.
Explanation: The adapter did not find this file.
Action: Add this file to the appropriate directory.

306

Error reading fileName. IOErrorMessage.
Explanation: Generic message format.
Action: Take the appropriate action based on the IOErrorMessage.

307

Invalid transaction definition: transactionName is missing the tagName tag.
Explanation: The transaction definition file is missing the indicated tag.
Action: Add the indicated tag to the transaction definition.

308

Invalid transaction definition: transactionName has an unknown type of
transactionType.
Explanation: The transaction definition is of an unknown type.
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Error Code

Description
Action: Assign a valid type (Oracle-to-IS or IS-to-Oracle) to the transaction
definition.

310

The load() method must be called before this method.
Explanation: The transaction definition is not loaded in the repository or shared
cache.
Action: Import the transaction definition into the repository or shared cache.

311

errSQL is only valid on Oracle-to-IS transactions.
Explanation: The transaction definition file has an invalid errSQL tag. This error
is typically caused by manually editing the transaction definition file and specifying
an incorrect structure.
Action: Locate the original transaction definition file and use it instead of the edited
file.

312

insertSQL is only valid on IS-to-Oracle transactions.
Explanation: The transaction definition file has an invalid insertSQL tag. This error
is typically caused by manually editing the transaction definition file and specifying
an incorrect structure.
Action: Locate the original transaction definition file and use it instead of the edited
file.

313

Error in the SQLPath. Unable to find alias aliasName at the following level
aliasName.
Explanation: This is an Internal Error, and indicates a corrupted service
configuration. This error could be caused by the contents of the repository or shared
cache being changed after the service has been configured, resulting in corrupt
service information.
Action: Refresh the service. If the error persists, delete the service and reconfigure
it.

314

Transaction definition is missing the tagName tag.
Explanation: The transaction definition is missing the indicated tag.
Action: Add the missing tag to the transaction definition.

316

Unable to update transaction definition. Missing transaction type.
Explanation: The transaction definition file is missing the transaction type tag.
This error is typically caused by manually editing the transaction definition file.
Action: Locate the original transaction definition file and use it instead of the edited
file.
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Error Code

Description

317

Missing transaction name.
Explanation: The transaction definition file is missing the transaction name tag.
This error is typically caused by manually editing the transaction definition file.
Action: Locate the original transaction definition file and use it instead of the edited
file.

318

Missing SQL Alias.
Explanation: The transaction definition file is missing the SQL Alias tag. This error
is typically caused by manually editing the transaction definition file.
Action: Locate the original transaction definition file and use it instead of the edited
file.

338

Unable to rollback.
Explanation: This error indicates an Execute SQL rollback exception, and is possibly
due to the adapter connection being lost.
Action: Check your network and database server.

600

Error encountered in alias aliasName: SQL errorMessage.
Explanation: During design time, the adapter could not execute the SQL statement
associated with the indicated alias. Typically this error occurs because the SQL
statement is invalid.
Action: Examine the transaction definition and check the SQL statement associated
with the alias. Correct it as necessary.

601

No data found for insertion.
Explanation: The data for insertion is not provided.
Action: Examine the service invocation and provide the necessary data for insertion.

602

Illformed transactionRecord input.
Explanation: The input for the transaction is not in the expected structure. This
error typically indicates a data mapping problem.
Action: Examine the service invocation and provide the proper data mapping.

603

Data inputs for required tables are not available.
Explanation: Run-time error. The required input data not provided for the INSERT.
This error is typically indicates a data mapping problem.
Action: Examine the service invocation mapping and provide the required input
data.
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Error Code

Description

604

Error log sql execution failed - error logged.
Explanation: The adapter service is not able to perform the SQL SELECT for the
error message that is logged in the Oracle Applications concurrent process
execution.
Action: Check Integration Server error log for further details.

605

Unable to perform insert - error logged.
Explanation: The adapter is not able to perform the SQL INSERT operation.
Action: Check Integration Server error log for further details.

606

Unable to perform select - error logged.
Explanation: The adapter is not able to perform the SQL SELECT operation.
Action: Check Integration Server error log for further details.

943

Attempting to get lock and update. Retry: {0}.
Explanation: The adapter cannot lock the repository or shared cache to update the
transaction definition.
Action: Make sure no other users are accessing the repository or shared cache for
the transaction definition being updated.

961

Invalid token count.
Explanation: Invalid Stored Procedure invocation syntax in the SQL statement of
the Oracle-to-IS transaction definition.
Action: Check the transaction definition and correct the stored procedure syntax.

979

Illegal character string: characterString.
Explanation: The transaction definition transport (.txp) file contents contain invalid
characters.
Action: Examine the transaction definition file and specify a valid transport file
name.

1000

Empty Error SQL.
Explanation: Error SQL is not specified in the transaction definition.
Action: Check the transaction definition and include the necessary Error SQL.

1001

No parameter named parameterName.
Explanation: Run time error. The adapter cannot find the input parameter required
by the stored procedures in the service invocations.
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Error Code

Description
Action: Check the service invocation mapping.

1002

Parameter index has no name.
Explanation: Run time error. The adapter cannot retrieve the parameter name for
a stored procedure from the Oracle database. Typically this error is caused by
using an inappropriate JDBC driver.
Action: Use the correct JDBC driver. See the webMethods Adapters System
Requirements for the correct JDBC driver.

1003

Resource Domain Lookup Failed errorMessage.
Explanation: The adapter is not able to configure the service.
Action: Turn on debug for further details.

1008

Transaction Names are not Available.
Explanation: Transaction definitions might have been deleted from the repository
or shared cache.
Action: Check the repository or shared cache to see if the transaction definition is
available.

1010

Select Transaction.
Explanation: While configuring an adapter service, you did not select a transaction
definition.
Action: Select a transaction.

1210

Transaction Names are not available.
Explanation: The transaction definition does not exist in the repository or shared
cache.
Action: Check the transaction definition and specify the transaction names.

1211

Tables are not available.
Explanation: For an IS-to-Oracle transaction definition, there is no table specified
for insertion.
Action: Check the transaction definition and specify a table.

8106

Failed to commit local transaction. errorMessage.
Explanation: This error indicates an Execute SQL commit exception, and is possibly
due to the adapter connection being lost.
Action: Check your network and database server.
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Error Code

Description

8107

Failed to rollback local transaction. errorMessage.
Explanation: This error indicates an Execute SQL rollback exception, and is possibly
due to the adapter connection being lost.
Action: Check your network and database server.

8200

The JDBC DataSource class className cannot be located.
Explanation: A DataSource class name was specified in the adapter Connection
Properties DataSource Class field, but the class cannot be located. Either the class
does not exist or the name was misspelled.
Action: Check the spelling and make sure the JDBC driver file is in the CLASSPATH
or in the Integration Server_directory /packages/ WmOAAdapter /code/jars directory.

8201

The JDBC DataSource class className cannot be instantiated.
Explanation: The JDBC driver's DataSource class failed to initialize.
Action: Use the correct JDBC driver. See the webMethods Adapters System
Requirements for the correct JDBC driver.

8203

Illegal property for JDBC DataSource class propertyName.
Explanation: An invalid property for the Datasource class was specified for the
connection.
Action: Refer to JDBC Driver manual for eligible properties.

8207

The JDBC DataSource class className does not support
LOCAL_TRANSACTION.
Explanation: This error is typically cause by using an inappropriate JDBC driver.
Action: Use the correct JDBC driver. See the webMethods Adapters System
Requirements for the correct JDBC driver.

8208

Cannot disconnect from the database errorMessage.
Explanation: A JDBC driver exception was thrown while the adapter was
attempting to close the database connection. This error might be caused by a lost
connection or the connection is already closed.
Action: Check your network and database server.

8312

Cannot commit the transaction to the database errorMessage.
Explanation: This error indicates an Execute SQL commit exception. Possible
reasons for the error are that the connection is lost or the Commit was
inappropriately executed.
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Error Code

Description
Action: Check your network and database server.

8319

Cannot get the list of table columns errorMessage.
Explanation: While configuring an Insert SQL adapter service, the adapter cannot
retrieve the table meta data. Typically this error is caused by using an inappropriate
JDBC driver.
Action: Use the correct JDBC driver. See “Installing Oracle Apps Adapter ” on
page 23 for the correct JDBC driver.

8320

Transaction File transactionDefinitionFileName has problems. Please correct it
or remove this file.
Explanation: While importing a transaction definition transport file (.txp), the
adapter detected invalid contents in the file.
Action: Correct the transaction definition transport file and reimport it, or remove
the file from the Integration Server_directory \packages\ WmOAAdapter \exchange
directory.
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Transaction Management Overview
This appendix provides an overview of using transactions. It describes how Integration Server
supports the built-in services in the WmART package used to manage explicit transactions for
your Oracle Apps Adapter services. See the webMethods Integration Server Built-In Services Reference
for your release.

Transactions
Integration Server considers a transaction to be one or more interactions with one or more resources
that are treated as a single logical unit of work. The interactions within a transaction are either all
committed or all rolled back. For example, if a transaction includes multiple database inserts, and
one or more inserts fail, all inserts are rolled back.
Integration Server supports a local transaction(LOCAL_TRANSACTION) which is a transaction
to a resource's local transaction mechanism.

Implicit and Explicit Transactions
Implicit transactions are automatically handled by Integration Server transaction manager. When
you define an explicit transaction, you define the start-on-completion boundaries of the transaction.
As such, implicit and explicit transactions need to be created and managed differently.
The following sections describe implicit and explicit transactions and how to manage them.

Implicit Transactions
With implicit transactions, Integration Server automatically manages local transactions without
requiring you to explicitly do anything. That is, the Integration Server starts and completes an
implicit transaction with no additional service calls required by the adapter user.
A transaction context, which the transaction manager uses to define a unit of work, starts when
an adapter service is encountered in a flow service execution. The connection required by the
adapter service is registered with the newly created context and used by the adapter service. If
another adapter service is encountered, the transaction context is searched to see if the connection
is already registered. If the connection is already registered, the adapter service uses this connection.
If the connection is not registered, a new connection instance is retrieved and registered with the
transaction.
Note that if the top level flow invokes another flow, adapter services in the child flow use the same
transaction context.
When the top level flow completes, the transaction is completed and is either committed or rolled
back, depending on the status (success or failure) of the top level flow.
A single transaction context can contain no more than one LOCAL_TRANSACTION connection.
If your flow contains adapter services that use more then one LOCAL_TRANSACTION connection,
you must use explicit transactions, which are described in the next section.
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For information about designing and using flows, see the webMethods Service Development Help for
your release. For more information about transaction types, see “Transaction Management of
Oracle Apps Adapter Connections” on page 16.

Explicit Transactions
You use explicit transactions when you need to explicitly control the transactional units of work.
To do this, you use additional services, known as built-in services, in your flow.
A transaction context starts when the pub.art.transaction.startTransaction() service is executed. The
transaction context is completed when either the pub.art.transaction.commitTransaction() or
pub.art.transaction.rollbackTransaction() service is executed. As with implicit transactions, a single
transaction context can contain no more than one LOCAL_TRANSACTION connection.
Note:
With explicit transactions, you must be sure to call either a commitTransaction() or
rollbackTransaction() each startTransaction(); otherwise you will have dangling transactions
which will require you to reboot Integration Server.
A new explicit transaction context can be started within a transaction context, provided that you
ensure that the transactions within the transaction context are completed in the reverse order they
were started-that is, the last transaction to start should be the first transaction to complete, and so
forth.
For example, consider the following is a valid construct:
pub.art.transaction.startTransaction()
pub.art.transaction.startTransaction()
pub.art.transaction.startTransaction()
pub.art.transaction.commitTransaction()
pub.art.transaction.commitTransaction()
pub.art.transaction.commitTransaction()

The following example shows an invalid construct:
pub.art.transaction.startTransaction()
pub.art.transaction.startTransaction()
pub.art.transaction.commitTransaction()
pub.art.transaction.commitTransaction()

For information about designing and using flows, see the webMethods Service Development Help for
your release. For more information about transaction types, see “Transaction Management of
Oracle Apps Adapter Connections” on page 16.

Changing the Integration Server Transaction Timeout Interval
The Integration Server default transaction timeout is no timeout (NO_TIMEOUT). To change the
server's transaction timeout interval, use a text editor to modify the server.cnf file and add the
parameter below. Note that this parameter does not exist by default in the server.cnf file; you must
add it to the file as described below.
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Be sure to shut down Integration Server before you edit this file. After you make changes, restart
the server.
Add the following parameter to the server.cnf file:
watt.art.tmgr.timeout=TransactionTimeout

where TransactionTimeout is the number of seconds before transaction timeout.
This transaction timeout parameter does not halt the execution of a flow; it is the maximum number
of seconds that a transaction can remain open and still be considered valid. For example, if your
current transaction has a timeout value of 60 seconds and your flow takes 120 seconds to complete,
the transaction manager will rollback all registered operations regardless of the execution status.
For more information about adding parameters to the server.cnf file, see the webMethods Integration
Server Administrator’s Guide for your release.
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